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1.0 Summary 
 
As part of the Federal Energy Regulatory Commission (FERC) relicensing 
procedure for the Park Mill/Menominee Hydroelectric Project (FERC #2744) in 
Marinette County, Wisconsin and Menominee County, Michigan, local resource 
agencies requested the licensee to perform a point intercept survey (PI) in order 
to access aquatic plant communities within the FERC Project Boundary of the 
Park Mill Impoundment (a.k.a. Upper Scott Flowage).  In addition, the licensee 
agreed to perform a survey to map occurrences of purple loosestrife (PL), curly-
leaf pondweed (CLP), and Eurasian watermilfoil (EWM) within the FERC Project 
Boundary of the Park Mill Impoundment concurrently with the PI.  In early August 
of 2011, the PI along with the meander surveys for PL, CLP, and EWM were 
performed at the Park Mill Impoundment.  Survey dates were 8/1 – 8/5, 8/11 – 
8/12, and 8/15 – 8/19. 
 
PI and meander survey data was collected and compiled, and is included within 
this report. Both EWM and CLP were found within the survey boundary.  PL was 
also found within the survey boundary.  Upon closer investigation of a number of 
PL occurrences, it was discovered that Galerucella (Cella) beetles, a biological 
control for PL, already existed on many plants and were having a noticeable 
effect on their vigor. 
 
 
2.0 Methods 
 
The limits of all surveys included in this report were defined as the waters and 
shoreline of the Park Mill Impoundment within the FERC Project Boundary as 
shown on the FERC Project Boundary Map (Exhibit G, Figure G-1 dated 
December 9, 2009) to be included in the Draft License Application.  A map 
showing these limits is included in Appendix A of this report. 
 
Garmin eTrex Vista HCx handheld GPS receivers with WAAS enabled were used 
to locate and mark GPS points during all surveys. 
 
A shallow draft motorboat was used to access most survey areas, however, in 
shallow, weed choked areas were motorboat travel was hampered, a kayak was 
used.  It was necessary to use a kayak to survey the area of Wright Slough as 
there was no motorboat launch in this portion of the impoundment. 
 
The waters between the boat barrier and spillway along with the waters of the 
power canal were off limits to boat traffic.  No survey points were sampled in 
these areas; however, the shorelines were scanned for PL. 
 



MENOMINEE/PARK MILL HYDROELECTRIC PROJECT Park Mill Impoundment Aquatic Plant Survey 
   
 

 
North American Hydro, Inc.  Page 2 
 
 

2.1 Point Intercept Survey (PI) 
 
Procedures described in the document titled Recommended Baseline 
Monitoring of Aquatic Plants in Wisconsin: Sampling Design, Field 
and Laboratory Procedures, Data Entry and Analysis, and 
Applications - WIDNR – March 2010 were followed for the PI performed 
at the Park Mill Impoundment.  A copy of this document is included in 
Appendix E in this report. Data collection points were obtained from the 
Wisconsin Department of Natural Resources.  Distance between data 
points was established at 60 meters.  If a data point was located outside of 
the survey boundary, it was not sampled. 
 
Maps and results of the PI are included in Appendix A in this report. 
 
2.2 Eurasian Water Milfoil (EWM) and Curly-leaf Pondweed (CLP)  
 
Occurrences of EWM and CLP were recorded during the PI. This data is 
included in Appendix A in this report.  If an area of EWM or CLP was 
encountered that was considered a “mat”, it was mapped by driving 
around the perimeter while plotting GPS points.  General mat conditions 
were noted and inventoried.  If it was not possible to circumnavigate the 
entire mat due to dense vegetation, shallow water, etc., the perimeter was 
estimated. 
 
It should be noted that the surveys were performed at a time of year when 
peak growth of CLP was most likely not occurring.  A second PI and 
meandered survey in May or early June for peak CLP detection would 
have been ideal, but it was not within the scope of this survey. 
 
Maps and results of the EWM and CLP surveys are included in 
Appendices B and C respectively in this report.  For underlying data 
regarding the mapped surveyed points in these Appendices, refer to the PI 
data in Appendix A. 

 
2.3 Purple Loosestrife (PL) 
 
The PL survey was accomplished by scanning the shoreline and shallow 
areas of the project waters from a boat.  Certain areas were surveyed 
from land where it was not practical or possible to observe from the boat.  
High powered (15 x 50) image stabilization binoculars were used to 
facilitate the spotting of plants.  When PL was identified, a GPS waypoint 
was created to map the location.  If it wasn’t possible to reach a PL 
location to create a waypoint, its location was estimated.  Notes were 
taken for each occurrence. 
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Galerucella beetles were identified at a number of locations.  Damage and 
presence was noted and is included in the data.  In order to quantify Cella 
damage, the following descriptions were used: 
 

Light – A few holes were detected in the leaves.  Plants are very 
vigorous and damage has little effect on the plants.  Beetles, eggs, 
and/or larvae may have been detected on one or more plants. 
 
Medium – Many holes were detected in leaves.  There is obvious 
“window paning” damage from larvae feeding.  Some of the 
blooming flower heads appear to be stunted.  Some stems appear 
to have been severed and may or may not have new growth that is 
undamaged.  Beetles, eggs, and/or larvae may have been detected 
on one or more plants. 
 
Heavy – Most leaves had severe damage and “window paning”.  All 
seed heads are stunted but still may have a few flowers.  Most of 
the plant is damaged but is still green.  Some new growth may have 
been seen.   Beetles, eggs, and/or larvae may have been detected 
on one or more plants. 
 
Very Heavy – The plant is 80% to 100% brown.  Other native plants 
in the surrounding area are still green. 

 
Maps and results of the PL survey are included in Appendix D in this 
report. 

 
2.4 Miscellaneous 
 
Previous to initially launching into Park Mill/Menominee Hydroelectric 
Project waters, the survey boats and survey equipment were treated with 
a bleach solution to prevent possible spread of invasive species from 
other locations.  After the survey was completed and before launching into 
other waters, the survey boats and survey equipment were again treated 
with a bleach solution.  Weeds were removed from boats and trailer after 
each recovery and before leaving the boat launch. 

 
 
3.0 Observations 
 

3.1 Point Intercept Survey (PI) 
 
During the PI, 48 species were identified.  Of these, 43 were by rake 
method and 5 were visual sightings.  An additional 9 species were 
identified during the meander boat survey. 
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Most of the shallow areas (3 feet or less) of the sloughs, bays, and areas 
off of the main river channel had weed mats too thick to be navigated 
effectively with a motor boat.  In a number of these areas, survey points 
could not be reached with a kayak. At shallower depths on the main river 
channel, weed growth was not as heavy and most points could be 
sampled.  The maximum depth where plants were retrieved was 8 feet. 
 
The most common species identified during the PI were Ceratophyllum 
demersum, Coontail 12.78% Relative Fequency (RF); Potamogeton 
zosteriformis, Flat-stem pondweed 9.20% RF; Lemna trisulca, Forked 
duckweed 8.94% RF; Spirodela polyrhiza, Large duckweed 8.69% (RF); 
Lemna minor, Small duckweed 8.60% RF; Elodea canadensis, Common 
waterweed 8.43% RF.  The PI results indicate that these 6 species 
comprised a combined RF of approximately 57% of all species 
encountered during the survey. 
 
Maps and results of the PI are included in Appendix A in this report. 
 
3.2 Eurasian Water Milfoil (EWM) and Curly-leaf Pondweed (CLP)  
 
During the PI, EWM was identified at 23 survey points by rake method and 
at 32 points visually while CLP was identified at 14 survey points by rake 
method and at 5 points visually.  Additionally, the PI indicated that EWM 
comprised 1.96% RF of all species encountered during the survey while 
CLP comprised 1.19% RF of all species encountered. 
 
During the meander survey, 9 EWM mats were identified covering an 
estimated area of 47.112 acres while one CLP mat was identified covering 
an estimated area of 6.56 acres.  Most EWM occurrences were sparse 
and all were mixed with native plants.  A couple of EWM mats had light to 
medium densities on the extreme upstream and downstream ends of the 
mats in the main river channel.  Otherwise, the densest part of any mat 
was usually the outside perimeter.  Where CLP was found, all occurrences 
were sparse. 
 
Maps and results of the EWM and CLP surveys are included in 
Appendices B and C respectively in this report.  For underlying data 
regarding the mapped surveyed points in these Appendices, refer to the PI 
data in Appendix A. 

 
3.3 Purple Loosestrife (PL) 
 
PL was identified at 22 locations.  Most were small occurrence of 5 or less 
plants, but two occurrences were estimated to have over 500 plants 
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(PKML PL015 and PKML PL0021) and another was estimated to have 
about 100 – 200 plants (PKML PL0022).  No PL was found on property 
owned by the licensee. 
 
Cella beetles were discovered to be present at a number of PL 
occurrences.  Beetles damage was confirmed on two of the three largest 
sites (PKML PL015 and PKML PL0022).  The survey crew was unable to 
get close enough to determine if there was Cella presence at the third 
large site (PKML PL0021), however, due to its close proximity to a site 
with Medium beetle damage (PKML PL022), beetles have most likely 
migrated there and are established. 
 
Although not a part of the survey, the crew searched for PL in the Lower 
Menominee River in order to evaluate whether the Cella beetles found in 
the Park Mill Impoundment were isolated populations or if beetles were 
more widespread within the riparian corridor.  A number of PL plants were 
found on the north side of Stephenson Island about 1.75 miles 
downstream from the nearest Cella beetle sighting at the Park Mill 
Impoundment.  Cella beetles and eggs were also found on the plants at 
Stephenson Island. 
 
. 

 
Galerucella Beetle, Egg, and Larvae on Purple Loosestrife at PKML PL014 (2011) 
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Galerucella Beetle and egg on Purple Loosestrife at Stephenson Island – Lower Menominee 
River (2011) 

 
Maps and results of the PL survey are included in Appendix D in this 
report. 

 
3.4 Miscellaneous 
 
Non-native phragmites are common in the near vicinity of the Park Mill 
Impoundment.  Although no plants were discovered within the survey 
boundary, heavy occurrences were spotted in road ditches within 300 
yards of the impoundment. 
 
A report is available describing aquatic plant communities from a survey 
performed in the riparian corridor downstream from the Park Mill 
Impoundment.  It is entitled An Aquatic Vegetation Survey of the Lower 
Scott Flowage & Lower Menominee River Marinette County, Wisconsin & 
Menominee County, Michigan - December 2010, by Tim Hoyman & Eddie 
Heath - Onterra, LLC - De Pere, WI - Funded by: United States 
Environmental Protection Agency, Wisconsin Dept. of Natural Resources, 
Michigan Dept. of Natural Resources and Environment and is a good 
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source for more information on aquatic plant conditions in the general 
area.  
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Point Intercept Survey (PI) Data and Maps 
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

49 45.107863 -87.660369 RESTRICTED - Boat Barrier
50 45.108480 -87.664158 11 TOO DEEP
51 45.108465 -87.663396 10 TOO DEEP
52 45.108449 -87.662634 7 S P 1
53 45.108433 -87.661871 4 S P 1 1 V V 1
54 45.108418 -87.661109 17 TOO DEEP
55 45.108402 -87.660347 13 TOO DEEP
56 45.109020 -87.664136 12 TOO DEEP
57 45.109004 -87.663374 5 M P NO VEGETATION V
58 45.108989 -87.662612 7 S P NO VEGETATION
59 45.108973 -87.661849 8 S P NO VEGETATION
60 45.108957 -87.661087 17 TOO DEEP
61 45.109575 -87.664876 6 S P 1 V
62 45.109560 -87.664114 11 TOO DEEP
63 45.109544 -87.663352 3 S P 1 1 1 1
64 45.109528 -87.662589 6 S P 1 1
65 45.109513 -87.661827 5 M P 2 2
66 45.109497 -87.661065 17 TOO DEEP
67 45.110115 -87.664854 11 TOO DEEP
68 45.110099 -87.664092 4 M P 1 1 1 1
69 45.110084 -87.663330 7 S P NO VEGETATION
70 45.110068 -87.662567 2 M P 1 V 1 1 V
71 45.110052 -87.661805 4 M P 2 1 1 1 1 1
72 45.110037 -87.661043 17 TOO DEEP
73 45.110021 -87.660281 4 R P NO VEGETATION
74 45.110654 -87.664832 12 TOO DEEP
75 45.110639 -87.664070 4 M P NO VEGETATION V
76 45.110623 -87.663308 8 S P 1
77 45.110608 -87.662545 1 S P 1 1 1 1 1
78 45.110592 -87.661783 3 M P 2 V 1 1 1 V 1
79 45.110576 -87.661021 4 M P 1 1 1 V 1 V
80 45.110561 -87.660259 16 TOO DEEP
81 45.111288 -87.669382 4 M P 1 1 1 1 V
82 45.111210 -87.665572 5 S P 1 1 1 1
83 45.111194 -87.664810 11 TOO DEEP
84 45.111178 -87.664048 4 M P 1 1 1
85 45.111163 -87.663285 6 S P 1 1
86 45.111147 -87.662523 2 M P 1 1 1 1
87 45.111132 -87.661761 3 M P 1 1 V 1 1 V 1 1
88 45.111116 -87.660999 3 M P 2 1 1 1 1 1 V
89 45.111100 -87.660237 18 TOO DEEP
90 45.111085 -87.659475 11 TOO DEEP
91 45.111858 -87.670885 1 M P 1 1 1 1
92 45.111843 -87.670123 5 M P 1 1 1 1 1
93 45.111827 -87.669360 5 M P 1 V
94 45.111812 -87.668598 6 M P 1 1 1
95 45.111796 -87.667836 8 M P 1 1
96 45.111780 -87.667074 7 M P
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

49 45.107863 -87.660369 RESTRICTED - Boat Barrier
50 45.108480 -87.664158 11 TOO DEEP
51 45.108465 -87.663396 10 TOO DEEP
52 45.108449 -87.662634 7 S P 1
53 45.108433 -87.661871 4 S P 1
54 45.108418 -87.661109 17 TOO DEEP
55 45.108402 -87.660347 13 TOO DEEP
56 45.109020 -87.664136 12 TOO DEEP
57 45.109004 -87.663374 5 M P NO VEGETATION
58 45.108989 -87.662612 7 S P NO VEGETATION
59 45.108973 -87.661849 8 S P NO VEGETATION
60 45.108957 -87.661087 17 TOO DEEP
61 45.109575 -87.664876 6 S P 1
62 45.109560 -87.664114 11 TOO DEEP
63 45.109544 -87.663352 3 S P 1
64 45.109528 -87.662589 6 S P 1
65 45.109513 -87.661827 5 M P 2
66 45.109497 -87.661065 17 TOO DEEP
67 45.110115 -87.664854 11 TOO DEEP
68 45.110099 -87.664092 4 M P 1
69 45.110084 -87.663330 7 S P NO VEGETATION
70 45.110068 -87.662567 2 M P 1
71 45.110052 -87.661805 4 M P 2
72 45.110037 -87.661043 17 TOO DEEP
73 45.110021 -87.660281 4 R P NO VEGETATION
74 45.110654 -87.664832 12 TOO DEEP
75 45.110639 -87.664070 4 M P NO VEGETATION
76 45.110623 -87.663308 8 S P 1
77 45.110608 -87.662545 1 S P 1
78 45.110592 -87.661783 3 M P 2
79 45.110576 -87.661021 4 M P 1
80 45.110561 -87.660259 16 TOO DEEP
81 45.111288 -87.669382 4 M P 1
82 45.111210 -87.665572 5 S P 1
83 45.111194 -87.664810 11 TOO DEEP
84 45.111178 -87.664048 4 M P 1
85 45.111163 -87.663285 6 S P 1
86 45.111147 -87.662523 2 M P 1
87 45.111132 -87.661761 3 M P 1
88 45.111116 -87.660999 3 M P 2
89 45.111100 -87.660237 18 TOO DEEP
90 45.111085 -87.659475 11 TOO DEEP
91 45.111858 -87.670885 1 M P 1
92 45.111843 -87.670123 5 M P 1
93 45.111827 -87.669360 5 M P 1
94 45.111812 -87.668598 6 M P 1
95 45.111796 -87.667836 8 M P 1
96 45.111780 -87.667074 7 M P
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

97 45.111749 -87.665550 10 TOO DEEP
98 45.111734 -87.664788 6 S P 1
99 45.111718 -87.664026 5 S P
100 45.111703 -87.663263 6 S P 1
101 45.111687 -87.662501 2 S P 1 1 1 1 1 1
102 45.111671 -87.661739 2 M P 1 1 1 1 1 V
103 45.111656 -87.660977 4 M P 3 3 1 1 1
104 45.111640 -87.660215 13 TOO DEEP
105 45.111624 -87.659453 10 TOO DEEP
106 45.112398 -87.670863 5 M P 1 1 1
107 45.112382 -87.670101 5 M P 1 1 1 1 V 1
108 45.112367 -87.669338 4 M P 1 1 1 1 V V
109 45.112351 -87.668576 NONNAVIGABLE
110 45.112336 -87.667814 5 M P 1 1 1 1 1 1
111 45.112320 -87.667052 5 M P 1 1
112 45.112305 -87.666290 8 S P 1 1
113 45.112289 -87.665528 6 S P 1
114 45.112273 -87.664766 7 S P 1
115 45.112258 -87.664004 6 S P NO VEGETATION
116 45.112242 -87.663241 6 S P 1 1 1
117 45.112227 -87.662479 2 S P 1 1 1 1 V 1
118 45.112211 -87.661717 NONNAVIGABLE
119 45.112195 -87.660955 8 S P 1
120 45.112180 -87.660193 12 TOO DEEP
121 45.112164 -87.659431 7 S P NO VEGETATION
122 45.112969 -87.672365 5 M P 1 1 1 1 1 1 V
123 45.112953 -87.671603 5 M P 1 1 1 1 1 1 1 V
124 45.112938 -87.670841 NONNAVIGABLE
125 45.112891 -87.668554 NONNAVIGABLE
126 45.112875 -87.667792 1 M P 1 1 1 1 1 1 1 1 V V
127 45.112860 -87.667030 5 M P 1 1 1 1 V 1
128 45.112844 -87.666268 4 M P 1 V 1 V
129 45.112829 -87.665506 5 S P 1
130 45.112813 -87.664744 4 M P 1 1 1 1 1
131 45.112797 -87.663982 5 S P NO VEGETATION
132 45.112782 -87.663219 5 M P 1 1
133 45.112766 -87.662457 NONNAVIGABLE
134 45.112751 -87.661695 6 M P NO VEGETATION V
135 45.112735 -87.660933 9 S P NO VEGETATION
136 45.112719 -87.660171 12 TOO DEEP
137 45.112704 -87.659409 5 M P NO VEGETATION
138 45.112688 -87.658647 3 S P 1
139 45.113508 -87.672343 5 M P 2 2 1 1 1 V V
140 45.113493 -87.671581 4 M P 2 1 1 1 1 1 V 1
141 45.113431 -87.668532 NONNAVIGABLE
142 45.113415 -87.667770 NONNAVIGABLE
143 45.113399 -87.667008 3 M P 1 1 1 1 1 V 1 1 V
144 45.113384 -87.666246 3 M P 1 V 1 1 1 1 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

97 45.111749 -87.665550 10 TOO DEEP
98 45.111734 -87.664788 6 S P 1
99 45.111718 -87.664026 5 S P
100 45.111703 -87.663263 6 S P 1
101 45.111687 -87.662501 2 S P 1
102 45.111671 -87.661739 2 M P 1
103 45.111656 -87.660977 4 M P 3
104 45.111640 -87.660215 13 TOO DEEP
105 45.111624 -87.659453 10 TOO DEEP
106 45.112398 -87.670863 5 M P 1
107 45.112382 -87.670101 5 M P 1
108 45.112367 -87.669338 4 M P 1
109 45.112351 -87.668576 NONNAVIGABLE
110 45.112336 -87.667814 5 M P 1
111 45.112320 -87.667052 5 M P 1
112 45.112305 -87.666290 8 S P 1
113 45.112289 -87.665528 6 S P 1
114 45.112273 -87.664766 7 S P 1
115 45.112258 -87.664004 6 S P NO VEGETATION
116 45.112242 -87.663241 6 S P 1
117 45.112227 -87.662479 2 S P 1
118 45.112211 -87.661717 NONNAVIGABLE
119 45.112195 -87.660955 8 S P 1
120 45.112180 -87.660193 12 TOO DEEP
121 45.112164 -87.659431 7 S P NO VEGETATION
122 45.112969 -87.672365 5 M P 1
123 45.112953 -87.671603 5 M P 1
124 45.112938 -87.670841 NONNAVIGABLE
125 45.112891 -87.668554 NONNAVIGABLE
126 45.112875 -87.667792 1 M P 1
127 45.112860 -87.667030 5 M P 1
128 45.112844 -87.666268 4 M P 1
129 45.112829 -87.665506 5 S P 1
130 45.112813 -87.664744 4 M P 1
131 45.112797 -87.663982 5 S P NO VEGETATION
132 45.112782 -87.663219 5 M P 1
133 45.112766 -87.662457 NONNAVIGABLE
134 45.112751 -87.661695 6 M P NO VEGETATION
135 45.112735 -87.660933 9 S P NO VEGETATION
136 45.112719 -87.660171 12 TOO DEEP
137 45.112704 -87.659409 5 M P NO VEGETATION
138 45.112688 -87.658647 3 S P 1
139 45.113508 -87.672343 5 M P 2
140 45.113493 -87.671581 4 M P 2
141 45.113431 -87.668532 NONNAVIGABLE
142 45.113415 -87.667770 NONNAVIGABLE
143 45.113399 -87.667008 3 M P 1
144 45.113384 -87.666246 3 M P 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

145 45.113368 -87.665484 5 S P 1 1
146 45.113353 -87.664722 5 S P 1 1 1 1
147 45.113337 -87.663959 6 S P 1
148 45.113321 -87.663197 5 M P 1 1
149 45.113306 -87.662435 6 S P 3 3
150 45.113290 -87.661673 8 S P NO VEGETATION
151 45.113275 -87.660911 8 S P NO VEGETATION
152 45.113259 -87.660149 11 TOO DEEP
153 45.113243 -87.659387 4 M P 1 1 1 1
154 45.114064 -87.673083 4 M P 2 V 1 1 1 1 1 V 1
155 45.114048 -87.672321 4 M P 2 2 1 1 1 1 V
156 45.113939 -87.666986 NONNAVIGABLE
157 45.113924 -87.666224 NONNAVIGABLE
158 45.113908 -87.665462 5 S P 1 1 1
159 45.113892 -87.664700 6 S P NO VEGETATION
160 45.113877 -87.663937 6 S P 1 1 1
161 45.113861 -87.663175 6 S P 1 1
162 45.113846 -87.662413 8 S P NO VEGETATION
163 45.113830 -87.661651 8 S P NO VEGETATION
164 45.113814 -87.660889 10 S P NO VEGETATION
165 45.113799 -87.660127 6 S P NO VEGETATION V
166 45.113783 -87.659365 10 TOO DEEP
167 45.114619 -87.673824 5 M P 3 3 1 1 1 1
168 45.114603 -87.673061 3 M P 2 1 2 1 1 1 V V
169 45.114588 -87.672299 NONNAVIGABLE
170 45.114479 -87.666964 NONNAVIGABLE
171 45.114463 -87.666202 4 S P 1 V V V 1 V
172 45.114448 -87.665440 6 S P NO VEGETATION
173 45.114432 -87.664678 8 S P NO VEGETATION
174 45.114416 -87.663915 8 S P NO VEGETATION
175 45.114401 -87.663153 10 TOO DEEP
176 45.114385 -87.662391 10 TOO DEEP
177 45.114370 -87.661629 10 TOO DEEP
178 45.114354 -87.660867 10 TOO DEEP
179 45.114338 -87.660105 8 S P NO VEGETATION
180 45.114323 -87.659342 5 M P 1 V 1 V
181 45.114307 -87.658580 6 M P NO VEGETATION
182 45.115174 -87.674564 NONNAVIGABLE
183 45.115158 -87.673802 3 M P 1 V 1 V 1 1 V V
184 45.115143 -87.673039 3 M P 1 V V 1 1 V 1 1 V
185 45.115003 -87.666180 6 S P 1 V V 1 V
186 45.114987 -87.665418 9 S P NO VEGETATION
187 45.114972 -87.664656 9 S P NO VEGETATION
188 45.114956 -87.663893 11 TOO DEEP
189 45.114940 -87.663131 12 TOO DEEP
190 45.114925 -87.662369 14 TOO DEEP
191 45.114909 -87.661607 9 S P NO VEGETATION
192 45.114894 -87.660845 5 M P 1 V
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

145 45.113368 -87.665484 5 S P 1
146 45.113353 -87.664722 5 S P 1
147 45.113337 -87.663959 6 S P 1
148 45.113321 -87.663197 5 M P 1
149 45.113306 -87.662435 6 S P 3
150 45.113290 -87.661673 8 S P NO VEGETATION
151 45.113275 -87.660911 8 S P NO VEGETATION
152 45.113259 -87.660149 11 TOO DEEP
153 45.113243 -87.659387 4 M P 1
154 45.114064 -87.673083 4 M P 2
155 45.114048 -87.672321 4 M P 2
156 45.113939 -87.666986 NONNAVIGABLE
157 45.113924 -87.666224 NONNAVIGABLE
158 45.113908 -87.665462 5 S P 1
159 45.113892 -87.664700 6 S P NO VEGETATION
160 45.113877 -87.663937 6 S P 1
161 45.113861 -87.663175 6 S P 1
162 45.113846 -87.662413 8 S P NO VEGETATION
163 45.113830 -87.661651 8 S P NO VEGETATION
164 45.113814 -87.660889 10 S P NO VEGETATION
165 45.113799 -87.660127 6 S P NO VEGETATION
166 45.113783 -87.659365 10 TOO DEEP
167 45.114619 -87.673824 5 M P 3
168 45.114603 -87.673061 3 M P 2
169 45.114588 -87.672299 NONNAVIGABLE
170 45.114479 -87.666964 NONNAVIGABLE
171 45.114463 -87.666202 4 S P 1
172 45.114448 -87.665440 6 S P NO VEGETATION
173 45.114432 -87.664678 8 S P NO VEGETATION
174 45.114416 -87.663915 8 S P NO VEGETATION
175 45.114401 -87.663153 10 TOO DEEP
176 45.114385 -87.662391 10 TOO DEEP
177 45.114370 -87.661629 10 TOO DEEP
178 45.114354 -87.660867 10 TOO DEEP
179 45.114338 -87.660105 8 S P NO VEGETATION
180 45.114323 -87.659342 5 M P 1
181 45.114307 -87.658580 6 M P NO VEGETATION
182 45.115174 -87.674564 NONNAVIGABLE
183 45.115158 -87.673802 3 M P 1
184 45.115143 -87.673039 3 M P 1
185 45.115003 -87.666180 6 S P 1
186 45.114987 -87.665418 9 S P NO VEGETATION
187 45.114972 -87.664656 9 S P NO VEGETATION
188 45.114956 -87.663893 11 TOO DEEP
189 45.114940 -87.663131 12 TOO DEEP
190 45.114925 -87.662369 14 TOO DEEP
191 45.114909 -87.661607 9 S P NO VEGETATION
192 45.114894 -87.660845 5 M P 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

193 45.114878 -87.660083 4 M P 1 V 1 V
194 45.114862 -87.659320 5 M P 1 V 1 1 V 1
195 45.114847 -87.658558 6 M P NO VEGETATION
196 45.115760 -87.676828 NONNAVIGABLE
197 45.115729 -87.675304 NONNAVIGABLE
198 45.115714 -87.674542 NONNAVIGABLE
199 45.115698 -87.673780 3 M P 1 1 1 1 1 1 V V
200 45.115683 -87.673017 3 M P 1 1 1 1 1 1 V V
201 45.115542 -87.666158 11 TOO DEEP
202 45.115527 -87.665396 11 TOO DEEP
203 45.115511 -87.664634 11 TOO DEEP
204 45.115496 -87.663871 14 TOO DEEP
205 45.115480 -87.663109 13 TOO DEEP
206 45.115449 -87.661585 4 M P 1 1 V V 1
207 45.115433 -87.660823 5 M P 1 1
208 45.115418 -87.660061 5 M P 1
209 45.115402 -87.659298 5 M P 1 1
210 45.116253 -87.674520 3 M P 2 1 1 1 V 1
211 45.116238 -87.673758 3 M P 2 1 2 1 1 1 1
212 45.116222 -87.672996 2 M P 1 1 1 1 1 1 V
213 45.116082 -87.666136 15 TOO DEEP
214 45.116067 -87.665374 12 TOO DEEP
215 45.116051 -87.664612 12 TOO DEEP
216 45.116035 -87.663849 4 R P NO VEGETATION
217 45.116808 -87.675260 NONNAVIGABLE
218 45.116793 -87.674498 NONNAVIGABLE
219 45.116777 -87.673736 3 M P 1 V V 1 V 1 1 V
220 45.116762 -87.672974 NONNAVIGABLE
221 45.116637 -87.666876 13 TOO DEEP
222 45.116622 -87.666114 13 TOO DEEP
223 45.116606 -87.665352 12 TOO DEEP
224 45.116591 -87.664589 16 TOO DEEP
225 45.116497 -87.660016 NONNAVIGABLE
226 45.117364 -87.676000 NONNAVIGABLE
227 45.117348 -87.675238 NONNAVIGABLE
228 45.117317 -87.673714 3 M P 1 V 1 1 1 1 V
229 45.117193 -87.667616 14 TOO DEEP
230 45.117177 -87.666854 13 TOO DEEP
231 45.117161 -87.666092 11 TOO DEEP
232 45.117146 -87.665330 11 TOO DEEP
233 45.117903 -87.675979 NONNAVIGABLE
234 45.117888 -87.675216 3 M P 3 2 1 1
235 45.117872 -87.674454 3 M P 2 1 2 1 1 1 1 V V 1
236 45.117857 -87.673692 4 M P 1 1 1 1 1 V V
237 45.117748 -87.668356 14 TOO DEEP
238 45.117732 -87.667594 13 TOO DEEP
239 45.117717 -87.666832 11 TOO DEEP
240 45.117701 -87.666070 8 S P NO VEGETATION V V V V V
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

193 45.114878 -87.660083 4 M P 1
194 45.114862 -87.659320 5 M P 1
195 45.114847 -87.658558 6 M P NO VEGETATION
196 45.115760 -87.676828 NONNAVIGABLE
197 45.115729 -87.675304 NONNAVIGABLE
198 45.115714 -87.674542 NONNAVIGABLE
199 45.115698 -87.673780 3 M P 1
200 45.115683 -87.673017 3 M P 1
201 45.115542 -87.666158 11 TOO DEEP
202 45.115527 -87.665396 11 TOO DEEP
203 45.115511 -87.664634 11 TOO DEEP
204 45.115496 -87.663871 14 TOO DEEP
205 45.115480 -87.663109 13 TOO DEEP
206 45.115449 -87.661585 4 M P 1
207 45.115433 -87.660823 5 M P 1
208 45.115418 -87.660061 5 M P 1
209 45.115402 -87.659298 5 M P 1
210 45.116253 -87.674520 3 M P 2
211 45.116238 -87.673758 3 M P 2
212 45.116222 -87.672996 2 M P 1
213 45.116082 -87.666136 15 TOO DEEP
214 45.116067 -87.665374 12 TOO DEEP
215 45.116051 -87.664612 12 TOO DEEP
216 45.116035 -87.663849 4 R P NO VEGETATION
217 45.116808 -87.675260 NONNAVIGABLE
218 45.116793 -87.674498 NONNAVIGABLE
219 45.116777 -87.673736 3 M P 1
220 45.116762 -87.672974 NONNAVIGABLE
221 45.116637 -87.666876 13 TOO DEEP
222 45.116622 -87.666114 13 TOO DEEP
223 45.116606 -87.665352 12 TOO DEEP
224 45.116591 -87.664589 16 TOO DEEP
225 45.116497 -87.660016 NONNAVIGABLE
226 45.117364 -87.676000 NONNAVIGABLE
227 45.117348 -87.675238 NONNAVIGABLE
228 45.117317 -87.673714 3 M P 1
229 45.117193 -87.667616 14 TOO DEEP
230 45.117177 -87.666854 13 TOO DEEP
231 45.117161 -87.666092 11 TOO DEEP
232 45.117146 -87.665330 11 TOO DEEP
233 45.117903 -87.675979 NONNAVIGABLE
234 45.117888 -87.675216 3 M P 3
235 45.117872 -87.674454 3 M P 2
236 45.117857 -87.673692 4 M P 1
237 45.117748 -87.668356 14 TOO DEEP
238 45.117732 -87.667594 13 TOO DEEP
239 45.117717 -87.666832 11 TOO DEEP
240 45.117701 -87.666070 8 S P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

241 45.117686 -87.665308 11 R P NO VEGETATION V
242 45.117670 -87.664545 2 S P 1
243 45.118458 -87.676719 NONNAVIGABLE
244 45.118443 -87.675957 3 M P 1 V V 1 1 V 1
245 45.118427 -87.675194 NONNAVIGABLE
246 45.118396 -87.673670 2 M P 1 1 1 1 V
247 45.118334 -87.670621 11 TOO DEEP
248 45.118319 -87.669859 14 TOO DEEP
249 45.118303 -87.669097 14 TOO DEEP
250 45.118287 -87.668334 12 TOO DEEP
251 45.118272 -87.667572 10 TOO DEEP
252 45.118256 -87.666810 8 S P NO VEGETATION
253 45.118241 -87.666048 13 TOO DEEP
254 45.118194 -87.663761 NONNAVIGABLE
255 45.118998 -87.676697 2 M P 1 V 1 1 1 1
256 45.118983 -87.675935 3 M P 3 1 2 1 1 1 1 V
257 45.118936 -87.673648 3 M P 1 1 1 V 1 1 1 1
258 45.118889 -87.671361 14 TOO DEEP
259 45.118874 -87.670599 12 TOO DEEP
260 45.118858 -87.669837 12 TOO DEEP
261 45.118843 -87.669075 10 TOO DEEP
262 45.118827 -87.668312 9 S P NO VEGETATION
263 45.118812 -87.667550 8 S P 1 1
264 45.118796 -87.666788 10 TOO DEEP
265 45.119538 -87.676675 2 M P 1 V 1 1 1 1 1 1 1
266 45.119476 -87.673626 3 M P 2 V 1 1 V 1 1 V
267 45.119445 -87.672102 13 TOO DEEP
268 45.119429 -87.671339 12 TOO DEEP
269 45.119413 -87.670577 12 TOO DEEP
270 45.119398 -87.669815 11 TOO DEEP
271 45.119382 -87.669053 10 TOO DEEP
272 45.119367 -87.668290 8 S P NO VEGETATION
273 45.119351 -87.667528 6 M P 1 1
274 45.120093 -87.677415 NONNAVIGABLE
275 45.120077 -87.676653 3 M P 2 V 1 V 1 1 1 1
276 45.120015 -87.673604 4 S P 1 V V 1 1 1 V 1
277 45.120000 -87.672842 4 S P 1 1 V V V
278 45.119984 -87.672080 12 TOO DEEP
279 45.119969 -87.671317 12 TOO DEEP
280 45.119953 -87.670555 10 TOO DEEP
281 45.119938 -87.669793 11 TOO DEEP
282 45.119922 -87.669031 2 S P 1 V 1 V 1
283 45.120648 -87.678156 NONNAVIGABLE
284 45.120633 -87.677393 2 M P 3 1 1 1 1 1
285 45.120571 -87.674344 NONNAVIGABLE
286 45.120555 -87.673582 2 S P 1 V 1 1 V 1 V
287 45.120539 -87.672820 12 TOO DEEP
288 45.120524 -87.672058 12 TOO DEEP
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

241 45.117686 -87.665308 11 R P NO VEGETATION
242 45.117670 -87.664545 2 S P 1
243 45.118458 -87.676719 NONNAVIGABLE
244 45.118443 -87.675957 3 M P 1
245 45.118427 -87.675194 NONNAVIGABLE
246 45.118396 -87.673670 2 M P 1
247 45.118334 -87.670621 11 TOO DEEP
248 45.118319 -87.669859 14 TOO DEEP
249 45.118303 -87.669097 14 TOO DEEP
250 45.118287 -87.668334 12 TOO DEEP
251 45.118272 -87.667572 10 TOO DEEP
252 45.118256 -87.666810 8 S P NO VEGETATION
253 45.118241 -87.666048 13 TOO DEEP
254 45.118194 -87.663761 NONNAVIGABLE
255 45.118998 -87.676697 2 M P 1
256 45.118983 -87.675935 3 M P 3
257 45.118936 -87.673648 3 M P 1
258 45.118889 -87.671361 14 TOO DEEP
259 45.118874 -87.670599 12 TOO DEEP
260 45.118858 -87.669837 12 TOO DEEP
261 45.118843 -87.669075 10 TOO DEEP
262 45.118827 -87.668312 9 S P NO VEGETATION
263 45.118812 -87.667550 8 S P 1
264 45.118796 -87.666788 10 TOO DEEP
265 45.119538 -87.676675 2 M P 1
266 45.119476 -87.673626 3 M P 2
267 45.119445 -87.672102 13 TOO DEEP
268 45.119429 -87.671339 12 TOO DEEP
269 45.119413 -87.670577 12 TOO DEEP
270 45.119398 -87.669815 11 TOO DEEP
271 45.119382 -87.669053 10 TOO DEEP
272 45.119367 -87.668290 8 S P NO VEGETATION
273 45.119351 -87.667528 6 M P 1
274 45.120093 -87.677415 NONNAVIGABLE
275 45.120077 -87.676653 3 M P 2
276 45.120015 -87.673604 4 S P 1
277 45.120000 -87.672842 4 S P 1
278 45.119984 -87.672080 12 TOO DEEP
279 45.119969 -87.671317 12 TOO DEEP
280 45.119953 -87.670555 10 TOO DEEP
281 45.119938 -87.669793 11 TOO DEEP
282 45.119922 -87.669031 2 S P 1
283 45.120648 -87.678156 NONNAVIGABLE
284 45.120633 -87.677393 2 M P 3
285 45.120571 -87.674344 NONNAVIGABLE
286 45.120555 -87.673582 2 S P 1
287 45.120539 -87.672820 12 TOO DEEP
288 45.120524 -87.672058 12 TOO DEEP
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

289 45.120508 -87.671295 11 TOO DEEP
290 45.120493 -87.670533 7 R P NO VEGETATION
291 45.121188 -87.678134 NONNAVIGABLE
292 45.121172 -87.677372 2 M P 1 V 1 V 1 1 1
293 45.121095 -87.673560 10 TOO DEEP
294 45.121079 -87.672798 11 TOO DEEP
295 45.121064 -87.672036 11 TOO DEEP
296 45.121048 -87.671273 15 TOO DEEP
297 45.121727 -87.678112 NONNAVIGABLE
298 45.121712 -87.677350 1 M P 2 2 1 1 1 1 1
299 45.121634 -87.673538 10 TOO DEEP
300 45.121619 -87.672776 10 TOO DEEP
301 45.121603 -87.672014 12 TOO DEEP
302 45.122267 -87.678090 2 M P 2 V 1 1 1 1 1 V V
303 45.122205 -87.675041 4 S P 1 1 V V
304 45.122190 -87.674279 9 S P NO VEGETATION
305 45.122174 -87.673516 9 S P NO VEGETATION
306 45.122158 -87.672754 11 S P NO VEGETATION
307 45.122143 -87.671992 10 TOO DEEP
308 45.122822 -87.678830 3 M P 2 V 1 1 V 1 1 1 V 1
309 45.122807 -87.678068 NONNAVIGABLE
310 45.122745 -87.675019 5 S P 1 1 V
311 45.122729 -87.674257 7 S P NO VEGETATION V
312 45.122714 -87.673494 9 S P NO VEGETATION
313 45.122698 -87.672732 13 TOO DEEP
314 45.122683 -87.671970 3 S P 1 1 1 V 1 1 1 V
315 45.122667 -87.671208 6 S P 1
316 45.123362 -87.678808 3 M P 1 V 1 V 1 1 V V V
317 45.123300 -87.675759 10 TOO DEEP
318 45.123284 -87.674997 7 S P NO VEGETATION
319 45.123269 -87.674235 8 S P NO VEGETATION
320 45.123253 -87.673472 10 TOO DEEP
321 45.123238 -87.672710 10 TOO DEEP
322 45.123222 -87.671948 7 S P 1 1 1
323 45.123207 -87.671186 1 S P 1 V V 1 1 1 1
324 45.123902 -87.678787 3 M P 3 1 1 1 V V
325 45.123840 -87.675737 2 S P 3 1 1 2 1 1 V 1
326 45.123824 -87.674975 7 S P NO VEGETATION
327 45.123808 -87.674213 9 S P NO VEGETATION
328 45.123793 -87.673451 10 TOO DEEP
329 45.123777 -87.672688 7 R P NO VEGETATION
330 45.123762 -87.671926 7 S P NO VEGETATION
331 45.124441 -87.678765 3 M P 2 1 1 V 1 1 V V
332 45.124426 -87.678002 3 M P 2 1 1 1 1 1 V V
333 45.124379 -87.675715 3 S P 1 1 1 1
334 45.124364 -87.674953 7 S P NO VEGETATION
335 45.124348 -87.674191 10 S P NO VEGETATION
336 45.124333 -87.673429 10 S P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

289 45.120508 -87.671295 11 TOO DEEP
290 45.120493 -87.670533 7 R P NO VEGETATION
291 45.121188 -87.678134 NONNAVIGABLE
292 45.121172 -87.677372 2 M P 1
293 45.121095 -87.673560 10 TOO DEEP
294 45.121079 -87.672798 11 TOO DEEP
295 45.121064 -87.672036 11 TOO DEEP
296 45.121048 -87.671273 15 TOO DEEP
297 45.121727 -87.678112 NONNAVIGABLE
298 45.121712 -87.677350 1 M P 2
299 45.121634 -87.673538 10 TOO DEEP
300 45.121619 -87.672776 10 TOO DEEP
301 45.121603 -87.672014 12 TOO DEEP
302 45.122267 -87.678090 2 M P 2
303 45.122205 -87.675041 4 S P 1
304 45.122190 -87.674279 9 S P NO VEGETATION
305 45.122174 -87.673516 9 S P NO VEGETATION
306 45.122158 -87.672754 11 S P NO VEGETATION
307 45.122143 -87.671992 10 TOO DEEP
308 45.122822 -87.678830 3 M P 2
309 45.122807 -87.678068 NONNAVIGABLE
310 45.122745 -87.675019 5 S P 1
311 45.122729 -87.674257 7 S P NO VEGETATION
312 45.122714 -87.673494 9 S P NO VEGETATION
313 45.122698 -87.672732 13 TOO DEEP
314 45.122683 -87.671970 3 S P 1
315 45.122667 -87.671208 6 S P 1
316 45.123362 -87.678808 3 M P 1
317 45.123300 -87.675759 10 TOO DEEP
318 45.123284 -87.674997 7 S P NO VEGETATION
319 45.123269 -87.674235 8 S P NO VEGETATION
320 45.123253 -87.673472 10 TOO DEEP
321 45.123238 -87.672710 10 TOO DEEP
322 45.123222 -87.671948 7 S P 1
323 45.123207 -87.671186 1 S P 1
324 45.123902 -87.678787 3 M P 3
325 45.123840 -87.675737 2 S P 3
326 45.123824 -87.674975 7 S P NO VEGETATION
327 45.123808 -87.674213 9 S P NO VEGETATION
328 45.123793 -87.673451 10 TOO DEEP
329 45.123777 -87.672688 7 R P NO VEGETATION
330 45.123762 -87.671926 7 S P NO VEGETATION
331 45.124441 -87.678765 3 M P 2
332 45.124426 -87.678002 3 M P 2
333 45.124379 -87.675715 3 S P 1
334 45.124364 -87.674953 7 S P NO VEGETATION
335 45.124348 -87.674191 10 S P NO VEGETATION
336 45.124333 -87.673429 10 S P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

337 45.124317 -87.672666 5 R P NO VEGETATION
338 45.124965 -87.677980 3 M P 3 1 1 1 1 1 V V
339 45.124919 -87.675694 6 S P 1 1
340 45.124903 -87.674931 10 S P NO VEGETATION
341 45.124888 -87.674169 11 S P NO VEGETATION
342 45.124872 -87.673407 12 S P NO VEGETATION
343 45.124857 -87.672644 4 M P 1
344 45.125505 -87.677959 2 M P 2 1 1 2 1 1 1 V 1
345 45.125490 -87.677196 3 M P 3 1 2 1 1 V
346 45.125474 -87.676434 2 M P 2 1 2 1 1 V 1
347 45.125459 -87.675672 10 S P NO VEGETATION
348 45.125443 -87.674909 13 S P NO VEGETATION
349 45.125427 -87.674147 11 S P NO VEGETATION
350 45.125412 -87.673385 13 S P NO VEGETATION
351 45.126029 -87.677174 NONNAVIGABLE
352 45.125998 -87.675650 14 TOO DEEP
353 45.125983 -87.674887 13 TOO DEEP
354 45.125967 -87.674125 12 S P NO VEGETATION
355 45.125952 -87.673363 10 S P NO VEGETATION
356 45.126538 -87.675628 16 S P NO VEGETATION
357 45.126522 -87.674865 10 S P NO VEGETATION
358 45.126507 -87.674103 2 S P 1 V 1 1
359 45.126491 -87.673341 14 R P NO VEGETATION
360 45.127093 -87.676368 12 R P NO VEGETATION
361 45.127077 -87.675606 14 TOO DEEP
362 45.127062 -87.674843 8 S P NO VEGETATION
363 45.127046 -87.674081 1 M P 2 1 1 1 1 V 1
364 45.127031 -87.673319 9 S P NO VEGETATION
365 45.127015 -87.672557 2 S P 1 1 1 1 1 V V
366 45.127633 -87.676346 17 TOO DEEP
367 45.127617 -87.675584 13 TOO DEEP
368 45.127602 -87.674822 3 S P 1 1
369 45.127586 -87.674059 1 M P 1 V 1 1 1 V V V
370 45.127571 -87.673297 8 S P 1 1
371 45.128188 -87.677087 15 TOO DEEP
372 45.128172 -87.676324 15 TOO DEEP
373 45.128157 -87.675562 8 S P NO VEGETATION
374 45.128141 -87.674800 1 M P 1 1 1 1 1 V V
375 45.128126 -87.674037 1 M P 1 1 1 1 1 V V
376 45.128110 -87.673275 10 TOO DEEP V V V V
377 45.128095 -87.672513 4 M P 1 V 1 1 V 1 1 V 1
378 45.128743 -87.677827 16 TOO DEEP
379 45.128727 -87.677065 18 S NO VEGETATION
380 45.128712 -87.676302 9 S P NO VEGETATION
381 45.128681 -87.674778 1 M P 2 2 1 1 V
382 45.128665 -87.674015 2 M P 2 1 1 1 1 1 V
383 45.128650 -87.673253 6 M P 1 1
384 45.128634 -87.672491 7 M P NO VEGETATION V
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

337 45.124317 -87.672666 5 R P NO VEGETATION
338 45.124965 -87.677980 3 M P 3
339 45.124919 -87.675694 6 S P 1
340 45.124903 -87.674931 10 S P NO VEGETATION
341 45.124888 -87.674169 11 S P NO VEGETATION
342 45.124872 -87.673407 12 S P NO VEGETATION
343 45.124857 -87.672644 4 M P 1
344 45.125505 -87.677959 2 M P 2
345 45.125490 -87.677196 3 M P 3
346 45.125474 -87.676434 2 M P 2
347 45.125459 -87.675672 10 S P NO VEGETATION
348 45.125443 -87.674909 13 S P NO VEGETATION
349 45.125427 -87.674147 11 S P NO VEGETATION
350 45.125412 -87.673385 13 S P NO VEGETATION
351 45.126029 -87.677174 NONNAVIGABLE
352 45.125998 -87.675650 14 TOO DEEP
353 45.125983 -87.674887 13 TOO DEEP
354 45.125967 -87.674125 12 S P NO VEGETATION
355 45.125952 -87.673363 10 S P NO VEGETATION
356 45.126538 -87.675628 16 S P NO VEGETATION
357 45.126522 -87.674865 10 S P NO VEGETATION
358 45.126507 -87.674103 2 S P 1
359 45.126491 -87.673341 14 R P NO VEGETATION
360 45.127093 -87.676368 12 R P NO VEGETATION
361 45.127077 -87.675606 14 TOO DEEP
362 45.127062 -87.674843 8 S P NO VEGETATION
363 45.127046 -87.674081 1 M P 2
364 45.127031 -87.673319 9 S P NO VEGETATION
365 45.127015 -87.672557 2 S P 1
366 45.127633 -87.676346 17 TOO DEEP
367 45.127617 -87.675584 13 TOO DEEP
368 45.127602 -87.674822 3 S P 1
369 45.127586 -87.674059 1 M P 1
370 45.127571 -87.673297 8 S P 1
371 45.128188 -87.677087 15 TOO DEEP
372 45.128172 -87.676324 15 TOO DEEP
373 45.128157 -87.675562 8 S P NO VEGETATION
374 45.128141 -87.674800 1 M P 1
375 45.128126 -87.674037 1 M P 1
376 45.128110 -87.673275 10 TOO DEEP
377 45.128095 -87.672513 4 M P 1
378 45.128743 -87.677827 16 TOO DEEP
379 45.128727 -87.677065 18 S NO VEGETATION
380 45.128712 -87.676302 9 S P NO VEGETATION
381 45.128681 -87.674778 1 M P 2
382 45.128665 -87.674015 2 M P 2
383 45.128650 -87.673253 6 M P 1
384 45.128634 -87.672491 7 M P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

385 45.128619 -87.671728 10 TOO DEEP
386 45.129298 -87.678568 14 TOO DEEP
387 45.129283 -87.677805 16 TOO DEEP
388 45.129267 -87.677043 10 S P NO VEGETATION
389 45.129236 -87.675518 3 M P 2 2 1 1 1 V V 1
390 45.129221 -87.674756 3 M P 2 1 1 1 1 1 1 V V V
391 45.129205 -87.673993 3 M P 3 3 1 1 1 1 V
392 45.129190 -87.673231 4 M P 2 2 V 1 1 V V
393 45.129158 -87.671706 1 R P 1 V 1 1 V
394 45.129143 -87.670944 9 M P NO VEGETATION
395 45.129853 -87.679308 4 R P 1 V
396 45.129838 -87.678546 15 TOO DEEP
397 45.129822 -87.677783 13 TOO DEEP
398 45.129807 -87.677021 2 S P 1
399 45.129791 -87.676259 1 M P 1 1 1 1 V
400 45.129776 -87.675496 4 M P 1 V 1 V V
401 45.129760 -87.674734 4 M P 1 V 1 1 1 1 1 1 V
402 45.129745 -87.673971 4 M P 3 3 1 1 1 1
403 45.129683 -87.670922 3 M P 1 1 1 1 1 V 1
404 45.130393 -87.679286 7 M P NO VEGETATION
405 45.130377 -87.678524 15 TOO DEEP
406 45.130362 -87.677761 14 TOO DEEP
407 45.130331 -87.676237 3 M P 2 2 1 1 1
408 45.130315 -87.675474 3 M P 1 1 1 1 1 1 V
409 45.130300 -87.674712 4 M P 3 3 V 1 1
410 45.130284 -87.673949 4 M P 2 2 1 1 1
411 45.130222 -87.670900 1 M P 1 1 1 1 1 V V
412 45.130207 -87.670138 8 M P 1 1
413 45.130933 -87.679264 8 S P NO VEGETATION
414 45.130917 -87.678502 14 TOO DEEP
415 45.130902 -87.677739 18 TOO DEEP
416 45.130871 -87.676215 2 M P 2 2 1 1 1 V V
417 45.130855 -87.675452 3 M P 3 2 1 1 1 V
418 45.130840 -87.674690 4 M P 3 3 1 1 1 V V V
419 45.130824 -87.673928 5 M P 1 1 1 V
420 45.130762 -87.670878 4 M P 1 1 1 1 1 1 1 V
421 45.130746 -87.670116 3 M P 1 1 1 1 1 1 V V
422 45.131472 -87.679242 4 R P 1 1 1
423 45.131457 -87.678480 14 TOO DEEP
424 45.131441 -87.677718 16 TOO DEEP
425 45.131379 -87.674668 4 M P 1 1 1 1
426 45.131317 -87.671618 1 S P 1 1 1 1 1 1 V
427 45.131302 -87.670856 3 M P 2 2 1 1 V V
428 45.131286 -87.670094 3 M P 1 1 1 V 1 1 V
429 45.132012 -87.679220 4 M P 1 1 1
430 45.131996 -87.678458 7 S P NO VEGETATION
431 45.131981 -87.677696 15 TOO DEEP
432 45.131826 -87.670072 3 M P 2 2 1 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

385 45.128619 -87.671728 10 TOO DEEP
386 45.129298 -87.678568 14 TOO DEEP
387 45.129283 -87.677805 16 TOO DEEP
388 45.129267 -87.677043 10 S P NO VEGETATION
389 45.129236 -87.675518 3 M P 2
390 45.129221 -87.674756 3 M P 2
391 45.129205 -87.673993 3 M P 3
392 45.129190 -87.673231 4 M P 2
393 45.129158 -87.671706 1 R P 1
394 45.129143 -87.670944 9 M P NO VEGETATION
395 45.129853 -87.679308 4 R P 1
396 45.129838 -87.678546 15 TOO DEEP
397 45.129822 -87.677783 13 TOO DEEP
398 45.129807 -87.677021 2 S P 1
399 45.129791 -87.676259 1 M P 1
400 45.129776 -87.675496 4 M P 1
401 45.129760 -87.674734 4 M P 1
402 45.129745 -87.673971 4 M P 3
403 45.129683 -87.670922 3 M P 1
404 45.130393 -87.679286 7 M P NO VEGETATION
405 45.130377 -87.678524 15 TOO DEEP
406 45.130362 -87.677761 14 TOO DEEP
407 45.130331 -87.676237 3 M P 2
408 45.130315 -87.675474 3 M P 1
409 45.130300 -87.674712 4 M P 3
410 45.130284 -87.673949 4 M P 2
411 45.130222 -87.670900 1 M P 1
412 45.130207 -87.670138 8 M P 1
413 45.130933 -87.679264 8 S P NO VEGETATION
414 45.130917 -87.678502 14 TOO DEEP
415 45.130902 -87.677739 18 TOO DEEP
416 45.130871 -87.676215 2 M P 2
417 45.130855 -87.675452 3 M P 3
418 45.130840 -87.674690 4 M P 3
419 45.130824 -87.673928 5 M P 1
420 45.130762 -87.670878 4 M P 1
421 45.130746 -87.670116 3 M P 1
422 45.131472 -87.679242 4 R P 1
423 45.131457 -87.678480 14 TOO DEEP
424 45.131441 -87.677718 16 TOO DEEP
425 45.131379 -87.674668 4 M P 1
426 45.131317 -87.671618 1 S P 1
427 45.131302 -87.670856 3 M P 2
428 45.131286 -87.670094 3 M P 1
429 45.132012 -87.679220 4 M P 1
430 45.131996 -87.678458 7 S P NO VEGETATION
431 45.131981 -87.677696 15 TOO DEEP
432 45.131826 -87.670072 3 M P 2
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

433 45.131810 -87.669309 4 S P 1 V 1 V V V 1 V V V
434 45.132552 -87.679199 2 M P 1 1 V 1 V 1 V
435 45.132536 -87.678436 2 S P 1 V 1 V V V
436 45.132521 -87.677674 14 TOO DEEP
437 45.132505 -87.676911 11 TOO DEEP
438 45.132365 -87.670050 5 M P 3 3 1 1
439 45.133091 -87.679177 NONNAVIGABLE
440 45.133076 -87.678414 NONNAVIGABLE
441 45.133060 -87.677652 9 S P NO VEGETATION
442 45.133045 -87.676889 14 TOO DEEP
443 45.133029 -87.676127 13 TOO DEEP
444 45.132905 -87.670028 4 M P 3 3 1 1 V
445 45.132874 -87.668503 NONNAVIGABLE
446 45.133615 -87.678392 3 M P 1 1 1 V V 1
447 45.133584 -87.676867 13 TOO DEEP
448 45.133569 -87.676105 15 TOO DEEP
449 45.133460 -87.670768 2 M P 1 1 1 1 1 1 1
450 45.133445 -87.670006 3 M P 2 1 1 1 1 V 1
451 45.133413 -87.668481 3 M P 1 1 1 1 1 1 V V
452 45.134124 -87.676846 17 TOO DEEP
453 45.134109 -87.676083 14 TOO DEEP
454 45.134093 -87.675321 7 R P 1 1
455 45.134015 -87.671509 NO INFORMATION
456 45.134000 -87.670746 2 M P 1 1 1 1 V V
457 45.133984 -87.669984 NONNAVIGABLE
458 45.133953 -87.668459 2 M P 1 1 1 1 1 1 1
459 45.133938 -87.667696 4 M P 1 1 1
460 45.134679 -87.677586 3 S P 1 V
461 45.134664 -87.676824 15 TOO DEEP
462 45.134648 -87.676061 12 TOO DEEP
463 45.134633 -87.675299 6 M P NO VEGETATION
464 45.134555 -87.671487 NONNAVIGABLE
465 45.134539 -87.670724 NONNAVIGABLE
466 45.134524 -87.669962 NONNAVIGABLE
467 45.134477 -87.667674 2 M P 2 1 1
468 45.135219 -87.677564 12 R P NO VEGETATION
469 45.135203 -87.676802 12 TOO DEEP
470 45.135188 -87.676039 12 TOO DEEP
471 45.135172 -87.675277 4 S P 1 1
472 45.135141 -87.673752 NONNAVIGABLE
473 45.135126 -87.672990 NONNAVIGABLE
474 45.135095 -87.671465 NONNAVIGABLE
475 45.135079 -87.670702 NONNAVIGABLE
476 45.135017 -87.667652 2 M P 2 1 1 1 1 V
477 45.135774 -87.678305 5 R P NO VEGETATION
478 45.135759 -87.677542 10 S P NO VEGETATION
479 45.135743 -87.676780 11 TOO DEEP
480 45.135728 -87.676017 9 S P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

433 45.131810 -87.669309 4 S P 1
434 45.132552 -87.679199 2 M P 1
435 45.132536 -87.678436 2 S P 1
436 45.132521 -87.677674 14 TOO DEEP
437 45.132505 -87.676911 11 TOO DEEP
438 45.132365 -87.670050 5 M P 3
439 45.133091 -87.679177 NONNAVIGABLE
440 45.133076 -87.678414 NONNAVIGABLE
441 45.133060 -87.677652 9 S P NO VEGETATION
442 45.133045 -87.676889 14 TOO DEEP
443 45.133029 -87.676127 13 TOO DEEP
444 45.132905 -87.670028 4 M P 3
445 45.132874 -87.668503 NONNAVIGABLE
446 45.133615 -87.678392 3 M P 1
447 45.133584 -87.676867 13 TOO DEEP
448 45.133569 -87.676105 15 TOO DEEP
449 45.133460 -87.670768 2 M P 1
450 45.133445 -87.670006 3 M P 2
451 45.133413 -87.668481 3 M P 1
452 45.134124 -87.676846 17 TOO DEEP
453 45.134109 -87.676083 14 TOO DEEP
454 45.134093 -87.675321 7 R P 1
455 45.134015 -87.671509 NO INFORMATION
456 45.134000 -87.670746 2 M P 1
457 45.133984 -87.669984 NONNAVIGABLE
458 45.133953 -87.668459 2 M P 1
459 45.133938 -87.667696 4 M P 1
460 45.134679 -87.677586 3 S P 1
461 45.134664 -87.676824 15 TOO DEEP
462 45.134648 -87.676061 12 TOO DEEP
463 45.134633 -87.675299 6 M P NO VEGETATION
464 45.134555 -87.671487 NONNAVIGABLE
465 45.134539 -87.670724 NONNAVIGABLE
466 45.134524 -87.669962 NONNAVIGABLE
467 45.134477 -87.667674 2 M P 2
468 45.135219 -87.677564 12 R P NO VEGETATION
469 45.135203 -87.676802 12 TOO DEEP
470 45.135188 -87.676039 12 TOO DEEP
471 45.135172 -87.675277 4 S P 1
472 45.135141 -87.673752 NONNAVIGABLE
473 45.135126 -87.672990 NONNAVIGABLE
474 45.135095 -87.671465 NONNAVIGABLE
475 45.135079 -87.670702 NONNAVIGABLE
476 45.135017 -87.667652 2 M P 2
477 45.135774 -87.678305 5 R P NO VEGETATION
478 45.135759 -87.677542 10 S P NO VEGETATION
479 45.135743 -87.676780 11 TOO DEEP
480 45.135728 -87.676017 9 S P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

481 45.135712 -87.675255 6 M P NO VEGETATION
482 45.135681 -87.673730 NONNAVIGABLE
483 45.135556 -87.667630 1 M P 2 1 1
484 45.136329 -87.679045 4 R P 1 1
485 45.136314 -87.678283 8 S P NO VEGETATION
486 45.136298 -87.677520 11 TOO DEEP
487 45.136283 -87.676758 11 TOO DEEP
488 45.136267 -87.675995 7 S P NO VEGETATION
489 45.136252 -87.675233 2 M P 3 V 1 V V 1 1
490 45.136236 -87.674470 NONNAVIGABLE
491 45.136884 -87.679786 6 M P NO VEGETATION
492 45.136869 -87.679023 6 S P NO VEGETATION
493 45.136853 -87.678261 11 TOO DEEP
494 45.136838 -87.677498 11 TOO DEEP
495 45.136822 -87.676736 8 S P NO VEGETATION
496 45.136807 -87.675973 2 S P 1 1
497 45.136791 -87.675211 NONNAVIGABLE
498 45.137455 -87.681289 3 M P 2 2 V V
499 45.137440 -87.680526 3 S P 1 V 1 1
500 45.137424 -87.679764 5 S P 1
501 45.137409 -87.679001 9 S P NO VEGETATION
502 45.137393 -87.678239 12 TOO DEEP
503 45.137378 -87.677476 9 S P NO VEGETATION
504 45.137362 -87.676714 5 S P 1 1 1 1
505 45.137347 -87.675952 NONNAVIGABLE
506 45.137331 -87.675189 NONNAVIGABLE
507 45.137995 -87.681267 3 M P 2 1 1 1 1
508 45.137979 -87.680504 5 S P 1 1 V
509 45.137964 -87.679742 7 S P 1
510 45.137948 -87.678980 12 TOO DEEP
511 45.137933 -87.678217 12 TOO DEEP
512 45.137917 -87.677455 5 S P 1
513 45.137886 -87.675930 NONNAVIGABLE
514 45.138534 -87.681245 5 S P 1 1 V V
515 45.138519 -87.680483 7 S P NO VEGETATION
516 45.138503 -87.679720 11 TOO DEEP
517 45.138488 -87.678958 13 TOO DEEP
518 45.138472 -87.678195 5 R P NO VEGETATION
519 45.139074 -87.681223 7 S P NO VEGETATION
520 45.139059 -87.680461 9 S P NO VEGETATION
521 45.139043 -87.679698 15 TOO DEEP
522 45.139028 -87.678936 13 TOO DEEP
523 45.139629 -87.681964 5 S P 1 1
524 45.139614 -87.681201 8 S P NO VEGETATION
525 45.139598 -87.680439 13 TOO DEEP
526 45.139583 -87.679676 12 TOO DEEP
527 45.140169 -87.681942 6 S P 1 1 1
528 45.140153 -87.681179 12 TOO DEEP
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

481 45.135712 -87.675255 6 M P NO VEGETATION
482 45.135681 -87.673730 NONNAVIGABLE
483 45.135556 -87.667630 1 M P 2
484 45.136329 -87.679045 4 R P 1
485 45.136314 -87.678283 8 S P NO VEGETATION
486 45.136298 -87.677520 11 TOO DEEP
487 45.136283 -87.676758 11 TOO DEEP
488 45.136267 -87.675995 7 S P NO VEGETATION
489 45.136252 -87.675233 2 M P 3
490 45.136236 -87.674470 NONNAVIGABLE
491 45.136884 -87.679786 6 M P NO VEGETATION
492 45.136869 -87.679023 6 S P NO VEGETATION
493 45.136853 -87.678261 11 TOO DEEP
494 45.136838 -87.677498 11 TOO DEEP
495 45.136822 -87.676736 8 S P NO VEGETATION
496 45.136807 -87.675973 2 S P 1
497 45.136791 -87.675211 NONNAVIGABLE
498 45.137455 -87.681289 3 M P 2
499 45.137440 -87.680526 3 S P 1
500 45.137424 -87.679764 5 S P 1
501 45.137409 -87.679001 9 S P NO VEGETATION
502 45.137393 -87.678239 12 TOO DEEP
503 45.137378 -87.677476 9 S P NO VEGETATION
504 45.137362 -87.676714 5 S P 1
505 45.137347 -87.675952 NONNAVIGABLE
506 45.137331 -87.675189 NONNAVIGABLE
507 45.137995 -87.681267 3 M P 2
508 45.137979 -87.680504 5 S P 1
509 45.137964 -87.679742 7 S P 1
510 45.137948 -87.678980 12 TOO DEEP
511 45.137933 -87.678217 12 TOO DEEP
512 45.137917 -87.677455 5 S P 1
513 45.137886 -87.675930 NONNAVIGABLE
514 45.138534 -87.681245 5 S P 1
515 45.138519 -87.680483 7 S P NO VEGETATION
516 45.138503 -87.679720 11 TOO DEEP
517 45.138488 -87.678958 13 TOO DEEP
518 45.138472 -87.678195 5 R P NO VEGETATION
519 45.139074 -87.681223 7 S P NO VEGETATION
520 45.139059 -87.680461 9 S P NO VEGETATION
521 45.139043 -87.679698 15 TOO DEEP
522 45.139028 -87.678936 13 TOO DEEP
523 45.139629 -87.681964 5 S P 1
524 45.139614 -87.681201 8 S P NO VEGETATION
525 45.139598 -87.680439 13 TOO DEEP
526 45.139583 -87.679676 12 TOO DEEP
527 45.140169 -87.681942 6 S P 1
528 45.140153 -87.681179 12 TOO DEEP
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

529 45.140138 -87.680417 12 TOO DEEP
530 45.140122 -87.679654 11 TOO DEEP
531 45.140724 -87.682683 6 S P NO VEGETATION
532 45.140708 -87.681920 8 S P NO VEGETATION
533 45.140693 -87.681158 11 TOO DEEP
534 45.140678 -87.680395 12 TOO DEEP
535 45.141264 -87.682661 7 S P NO VEGETATION
536 45.141248 -87.681898 8 S P NO VEGETATION
537 45.141233 -87.681136 12 TOO DEEP
538 45.141217 -87.680373 11 TOO DEEP
539 45.141202 -87.679611 NONNAVIGABLE
540 45.141803 -87.682639 8 S P NO VEGETATION
541 45.141788 -87.681876 10 TOO DEEP
542 45.141772 -87.681114 11 TOO DEEP
543 45.141757 -87.680351 3 S P 1 1 V V
544 45.142358 -87.683379 8 S P NO VEGETATION
545 45.142343 -87.682617 8 S P NO VEGETATION
546 45.142327 -87.681854 10 S P NO VEGETATION
547 45.142312 -87.681092 12 TOO DEEP
548 45.142914 -87.684120 7 S P 1 1
549 45.142898 -87.683358 7 S P NO VEGETATION
550 45.142883 -87.682595 10 TOO DEEP
551 45.142867 -87.681833 9 S P NO VEGETATION
552 45.142852 -87.681070 2 R P NO VEGETATION V V V V
553 45.143469 -87.684861 9 S P NO VEGETATION
554 45.143453 -87.684098 8 S P NO VEGETATION
555 45.143438 -87.683336 9 S P NO VEGETATION
556 45.143422 -87.682573 8 S P NO VEGETATION
557 45.143407 -87.681811 5 R P 1
558 45.143391 -87.681048 3 M P 3 3 1 1 1 V V
559 45.144024 -87.685602 9 S P NO VEGETATION
560 45.144008 -87.684839 9 S P NO VEGETATION
561 45.143993 -87.684076 8 S P NO VEGETATION
562 45.143977 -87.683314 10 R P 1
563 45.143962 -87.682551 6 S P 1
564 45.144579 -87.686342 4 S P 1
565 45.144563 -87.685580 11 TOO DEEP
566 45.144548 -87.684817 9 S P NO VEGETATION
567 45.144533 -87.684055 9 S P 1
568 45.144517 -87.683292 6 S P 1
569 45.144502 -87.682529 4 S P 1 1 1 V
570 45.145134 -87.687083 6 R P NO VEGETATION
571 45.145119 -87.686320 12 TOO DEEP
572 45.145103 -87.685558 12 TOO DEEP
573 45.145088 -87.684795 7 S P NO VEGETATION
574 45.145072 -87.684033 7 S P NO VEGETATION
575 45.145057 -87.683270 4 S P 1
576 45.145689 -87.687824 7 R P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

529 45.140138 -87.680417 12 TOO DEEP
530 45.140122 -87.679654 11 TOO DEEP
531 45.140724 -87.682683 6 S P NO VEGETATION
532 45.140708 -87.681920 8 S P NO VEGETATION
533 45.140693 -87.681158 11 TOO DEEP
534 45.140678 -87.680395 12 TOO DEEP
535 45.141264 -87.682661 7 S P NO VEGETATION
536 45.141248 -87.681898 8 S P NO VEGETATION
537 45.141233 -87.681136 12 TOO DEEP
538 45.141217 -87.680373 11 TOO DEEP
539 45.141202 -87.679611 NONNAVIGABLE
540 45.141803 -87.682639 8 S P NO VEGETATION
541 45.141788 -87.681876 10 TOO DEEP
542 45.141772 -87.681114 11 TOO DEEP
543 45.141757 -87.680351 3 S P 1
544 45.142358 -87.683379 8 S P NO VEGETATION
545 45.142343 -87.682617 8 S P NO VEGETATION
546 45.142327 -87.681854 10 S P NO VEGETATION
547 45.142312 -87.681092 12 TOO DEEP
548 45.142914 -87.684120 7 S P 1
549 45.142898 -87.683358 7 S P NO VEGETATION
550 45.142883 -87.682595 10 TOO DEEP
551 45.142867 -87.681833 9 S P NO VEGETATION
552 45.142852 -87.681070 2 R P NO VEGETATION
553 45.143469 -87.684861 9 S P NO VEGETATION
554 45.143453 -87.684098 8 S P NO VEGETATION
555 45.143438 -87.683336 9 S P NO VEGETATION
556 45.143422 -87.682573 8 S P NO VEGETATION
557 45.143407 -87.681811 5 R P 1
558 45.143391 -87.681048 3 M P 3
559 45.144024 -87.685602 9 S P NO VEGETATION
560 45.144008 -87.684839 9 S P NO VEGETATION
561 45.143993 -87.684076 8 S P NO VEGETATION
562 45.143977 -87.683314 10 R P 1
563 45.143962 -87.682551 6 S P 1
564 45.144579 -87.686342 4 S P 1
565 45.144563 -87.685580 11 TOO DEEP
566 45.144548 -87.684817 9 S P NO VEGETATION
567 45.144533 -87.684055 9 S P 1
568 45.144517 -87.683292 6 S P 1
569 45.144502 -87.682529 4 S P 1
570 45.145134 -87.687083 6 R P NO VEGETATION
571 45.145119 -87.686320 12 TOO DEEP
572 45.145103 -87.685558 12 TOO DEEP
573 45.145088 -87.684795 7 S P NO VEGETATION
574 45.145072 -87.684033 7 S P NO VEGETATION
575 45.145057 -87.683270 4 S P 1
576 45.145689 -87.687824 7 R P NO VEGETATION
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

577 45.145674 -87.687061 12 TOO DEEP
578 45.145658 -87.686299 11 TOO DEEP
579 45.145643 -87.685536 6 M P NO VEGETATION
580 45.145627 -87.684773 8 S P NO VEGETATION
581 45.145612 -87.684011 5 M P 1 1
582 45.146244 -87.688565 14 TOO DEEP
583 45.146229 -87.687802 12 TOO DEEP
584 45.146213 -87.687039 8 S P NO VEGETATION
585 45.146198 -87.686277 5 S P NO VEGETATION V
586 45.146182 -87.685514 7 S P NO VEGETATION
587 45.146167 -87.684752 NONNAVIGABLE
588 45.146815 -87.690068 9 R P NO VEGETATION
589 45.146799 -87.689305 12 TOO DEEP
590 45.146784 -87.688543 9 S P NO VEGETATION
591 45.146768 -87.687780 6 S P 1
592 45.146753 -87.687018 5 M P 1 V 1 1 1
593 45.146738 -87.686255 6 M P NO VEGETATION
594 45.147385 -87.691571 11 TOO DEEP
595 45.147370 -87.690809 12 TOO DEEP
596 45.147354 -87.690046 7 S P NO VEGETATION
597 45.147339 -87.689284 9 S P NO VEGETATION
598 45.147324 -87.688521 5 S P 1 1 1
599 45.147308 -87.687758 5 S P 1 1 1
600 45.147293 -87.686996 5 M P 1 1
601 45.147277 -87.686233 7 S P NO VEGETATION
602 45.147925 -87.691550 11 TOO DEEP
603 45.147910 -87.690787 8 S P NO VEGETATION
604 45.147894 -87.690024 7 S P 1
605 45.147879 -87.689262 NONNAVIGABLE
606 45.147863 -87.688499 4 M P 1 1
607 45.147848 -87.687736 5 S P 1 1
608 45.147832 -87.686974 5 S P 1 1
609 45.148495 -87.693053 BEYOND PROJECT BOUNDARY
610 45.148480 -87.692290 10 R P NO VEGETATION
611 45.148465 -87.691528 12 TOO DEEP
612 45.148449 -87.690765 6 S P 1
613 45.148434 -87.690003 5 S P 1
614 45.148418 -87.689240 3 S P 1 1 1
615 45.148403 -87.688477 3 S P 1
616 45.148387 -87.687715 5 R P NO VEGETATION
617 45.149051 -87.693794 BEYOND PROJECT BOUNDARY
618 45.149035 -87.693031 BEYOND PROJECT BOUNDARY
619 45.149020 -87.692269 BEYOND PROJECT BOUNDARY
620 45.149004 -87.691506 8 S P NO VEGETATION
621 45.148989 -87.690743 7 S P NO VEGETATION
622 45.148973 -87.689981 4 S P 1
623 45.148958 -87.689218 4 S P 1
624 45.148943 -87.688455 4 S P 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

577 45.145674 -87.687061 12 TOO DEEP
578 45.145658 -87.686299 11 TOO DEEP
579 45.145643 -87.685536 6 M P NO VEGETATION
580 45.145627 -87.684773 8 S P NO VEGETATION
581 45.145612 -87.684011 5 M P 1
582 45.146244 -87.688565 14 TOO DEEP
583 45.146229 -87.687802 12 TOO DEEP
584 45.146213 -87.687039 8 S P NO VEGETATION
585 45.146198 -87.686277 5 S P NO VEGETATION
586 45.146182 -87.685514 7 S P NO VEGETATION
587 45.146167 -87.684752 NONNAVIGABLE
588 45.146815 -87.690068 9 R P NO VEGETATION
589 45.146799 -87.689305 12 TOO DEEP
590 45.146784 -87.688543 9 S P NO VEGETATION
591 45.146768 -87.687780 6 S P 1
592 45.146753 -87.687018 5 M P 1
593 45.146738 -87.686255 6 M P NO VEGETATION
594 45.147385 -87.691571 11 TOO DEEP
595 45.147370 -87.690809 12 TOO DEEP
596 45.147354 -87.690046 7 S P NO VEGETATION
597 45.147339 -87.689284 9 S P NO VEGETATION
598 45.147324 -87.688521 5 S P 1
599 45.147308 -87.687758 5 S P 1
600 45.147293 -87.686996 5 M P 1
601 45.147277 -87.686233 7 S P NO VEGETATION
602 45.147925 -87.691550 11 TOO DEEP
603 45.147910 -87.690787 8 S P NO VEGETATION
604 45.147894 -87.690024 7 S P 1
605 45.147879 -87.689262 NONNAVIGABLE
606 45.147863 -87.688499 4 M P 1
607 45.147848 -87.687736 5 S P 1
608 45.147832 -87.686974 5 S P 1
609 45.148495 -87.693053 BEYOND PROJECT BOUNDARY
610 45.148480 -87.692290 10 R P NO VEGETATION
611 45.148465 -87.691528 12 TOO DEEP
612 45.148449 -87.690765 6 S P 1
613 45.148434 -87.690003 5 S P 1
614 45.148418 -87.689240 3 S P 1
615 45.148403 -87.688477 3 S P 1
616 45.148387 -87.687715 5 R P NO VEGETATION
617 45.149051 -87.693794 BEYOND PROJECT BOUNDARY
618 45.149035 -87.693031 BEYOND PROJECT BOUNDARY
619 45.149020 -87.692269 BEYOND PROJECT BOUNDARY
620 45.149004 -87.691506 8 S P NO VEGETATION
621 45.148989 -87.690743 7 S P NO VEGETATION
622 45.148973 -87.689981 4 S P 1
623 45.148958 -87.689218 4 S P 1
624 45.148943 -87.688455 4 S P 1
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

625 45.149667 -87.697585 BEYOND PROJECT BOUNDARY
626 45.149652 -87.696823 BEYOND PROJECT BOUNDARY
627 45.149636 -87.696060 BEYOND PROJECT BOUNDARY
628 45.149621 -87.695297 BEYOND PROJECT BOUNDARY
629 45.149606 -87.694535 BEYOND PROJECT BOUNDARY
630 45.149590 -87.693772 BEYOND PROJECT BOUNDARY
631 45.149575 -87.693009 BEYOND PROJECT BOUNDARY
632 45.149559 -87.692247 BEYOND PROJECT BOUNDARY
633 45.149544 -87.691484 BEYOND PROJECT BOUNDARY
634 45.149529 -87.690722 5 M P NO VEGETATION
635 45.149513 -87.689959 8 R P NO VEGETATION
636 45.150238 -87.699089 BEYOND PROJECT BOUNDARY
637 45.150222 -87.698326 BEYOND PROJECT BOUNDARY
638 45.150207 -87.697564 BEYOND PROJECT BOUNDARY
639 45.150191 -87.696801 BEYOND PROJECT BOUNDARY
640 45.150176 -87.696038 BEYOND PROJECT BOUNDARY
641 45.150161 -87.695276 BEYOND PROJECT BOUNDARY
642 45.150145 -87.694513 BEYOND PROJECT BOUNDARY
643 45.150130 -87.693750 BEYOND PROJECT BOUNDARY
644 45.150114 -87.692988 BEYOND PROJECT BOUNDARY
645 45.150099 -87.692225 BEYOND PROJECT BOUNDARY
646 45.150084 -87.691462 BEYOND PROJECT BOUNDARY
647 45.150777 -87.699067 BEYOND PROJECT BOUNDARY
648 45.150762 -87.698305 BEYOND PROJECT BOUNDARY
649 45.150747 -87.697542 BEYOND PROJECT BOUNDARY
650 45.150731 -87.696779 BEYOND PROJECT BOUNDARY
651 45.150716 -87.696017 BEYOND PROJECT BOUNDARY
652 45.150700 -87.695254 BEYOND PROJECT BOUNDARY
653 45.150685 -87.694491 BEYOND PROJECT BOUNDARY
654 45.150670 -87.693729 BEYOND PROJECT BOUNDARY
655 45.150654 -87.692966 BEYOND PROJECT BOUNDARY
656 45.151317 -87.699045 BEYOND PROJECT BOUNDARY
657 45.151302 -87.698283 BEYOND PROJECT BOUNDARY
658 45.151286 -87.697520 BEYOND PROJECT BOUNDARY
659 45.151271 -87.696757 BEYOND PROJECT BOUNDARY
660 45.151255 -87.695995 BEYOND PROJECT BOUNDARY
661 45.151240 -87.695232 BEYOND PROJECT BOUNDARY
662 45.151225 -87.694469 BEYOND PROJECT BOUNDARY
663 45.151209 -87.693707 BEYOND PROJECT BOUNDARY
664 45.151764 -87.694448 BEYOND PROJECT BOUNDARY
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Field Crew

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR

Name
County
WBIC
Date

625 45.149667 -87.697585 BEYOND PROJECT BOUNDARY
626 45.149652 -87.696823 BEYOND PROJECT BOUNDARY
627 45.149636 -87.696060 BEYOND PROJECT BOUNDARY
628 45.149621 -87.695297 BEYOND PROJECT BOUNDARY
629 45.149606 -87.694535 BEYOND PROJECT BOUNDARY
630 45.149590 -87.693772 BEYOND PROJECT BOUNDARY
631 45.149575 -87.693009 BEYOND PROJECT BOUNDARY
632 45.149559 -87.692247 BEYOND PROJECT BOUNDARY
633 45.149544 -87.691484 BEYOND PROJECT BOUNDARY
634 45.149529 -87.690722 5 M P NO VEGETATION
635 45.149513 -87.689959 8 R P NO VEGETATION
636 45.150238 -87.699089 BEYOND PROJECT BOUNDARY
637 45.150222 -87.698326 BEYOND PROJECT BOUNDARY
638 45.150207 -87.697564 BEYOND PROJECT BOUNDARY
639 45.150191 -87.696801 BEYOND PROJECT BOUNDARY
640 45.150176 -87.696038 BEYOND PROJECT BOUNDARY
641 45.150161 -87.695276 BEYOND PROJECT BOUNDARY
642 45.150145 -87.694513 BEYOND PROJECT BOUNDARY
643 45.150130 -87.693750 BEYOND PROJECT BOUNDARY
644 45.150114 -87.692988 BEYOND PROJECT BOUNDARY
645 45.150099 -87.692225 BEYOND PROJECT BOUNDARY
646 45.150084 -87.691462 BEYOND PROJECT BOUNDARY
647 45.150777 -87.699067 BEYOND PROJECT BOUNDARY
648 45.150762 -87.698305 BEYOND PROJECT BOUNDARY
649 45.150747 -87.697542 BEYOND PROJECT BOUNDARY
650 45.150731 -87.696779 BEYOND PROJECT BOUNDARY
651 45.150716 -87.696017 BEYOND PROJECT BOUNDARY
652 45.150700 -87.695254 BEYOND PROJECT BOUNDARY
653 45.150685 -87.694491 BEYOND PROJECT BOUNDARY
654 45.150670 -87.693729 BEYOND PROJECT BOUNDARY
655 45.150654 -87.692966 BEYOND PROJECT BOUNDARY
656 45.151317 -87.699045 BEYOND PROJECT BOUNDARY
657 45.151302 -87.698283 BEYOND PROJECT BOUNDARY
658 45.151286 -87.697520 BEYOND PROJECT BOUNDARY
659 45.151271 -87.696757 BEYOND PROJECT BOUNDARY
660 45.151255 -87.695995 BEYOND PROJECT BOUNDARY
661 45.151240 -87.695232 BEYOND PROJECT BOUNDARY
662 45.151225 -87.694469 BEYOND PROJECT BOUNDARY
663 45.151209 -87.693707 BEYOND PROJECT BOUNDARY
664 45.151764 -87.694448 BEYOND PROJECT BOUNDARY

Po
ta

m
og

et
on

 p
ra

el
on

gu
s,

 W
hi

te
-

st
em

 p
on

dw
ee

d

Po
ta

m
og

et
on

 p
us

ill
us

, S
m

al
l 

po
nd

w
ee

d

Po
ta

m
og

et
on

 ri
ch

ar
ds

on
ii,

 
C

la
sp

in
g-

le
af

 p
on

dw
ee

d

Po
ta

m
og

et
on

 ro
bb

in
si

i, 
Fe

rn
 

po
nd

w
ee

d

Po
ta

m
og

et
on

 s
tr

ic
tif

ol
iu

s,
 S

tif
f 

po
nd

w
ee

d

Po
ta

m
og

et
on

 z
os

te
rif

or
m

is
, F

la
t-

st
em

 p
on

dw
ee

d

R
an

un
cu

lu
s 

aq
ua

til
is

, W
hi

te
 

w
at

er
 c

ro
w

fo
ot

R
an

un
cu

lu
s 

fla
be

lla
ris

, Y
el

lo
w

 
w

at
er

 c
ro

w
fo

ot

R
an

un
cu

lu
s 

fla
m

m
ul

a,
 C

re
ep

in
g 

sp
ea

rw
or

t

Sa
gi

tta
ria

 la
tif

ol
ia

, C
om

m
on

 
ar

ro
w

he
ad

Sp
ar

ga
ni

um
 e

ur
yc

ar
pu

m
, 

C
om

m
on

 b
ur

-r
ee

d

Sp
ar

ga
ni

um
 n

at
an

s,
 S

m
al

l b
ur

-
re

ed

Sp
iro

de
la

 p
ol

yr
hi

za
, L

ar
ge

 
du

ck
w

ee
d

St
uc

ke
ni

a 
pe

ct
in

at
a,

 S
ag

o 
po

nd
w

ee
d

U
tr

ic
ul

ar
ia

 g
em

in
is

ca
pa

, T
w

in
-

st
em

m
ed

 b
la

dd
er

w
or

t

U
tr

ic
ul

ar
ia

 m
in

or
, S

m
al

l 
bl

ad
de

rw
or

t

U
tr

ic
ul

ar
ia

 v
ul

ga
ris

, C
om

m
on

 
bl

ad
de

rw
or

t

Va
lli

sn
er

ia
 a

m
er

ic
an

a,
 W

ild
 

ce
le

ry

W
ol

ffi
a 

co
lu

m
bi

an
a,

 C
om

m
on

 
w

at
er

m
ea

l

Zi
za

ni
a 

sp
., 

W
ild

 ri
ce

A
qu

at
ic

 m
os

s

Fi
la

m
en

to
us

 a
lg

ae

R
ic

ci
a 

flu
ita

ns
, S

le
nd

er
 ri

cc
ia

Si
um

 s
ua

ve
, W

at
er

 p
ar

sn
ip

 
(V

ou
ch

er
 R

A
L-

20
11

-0
34

)

U
ni

de
nt

ifi
ed

 (S
m

al
l?

) P
on

dw
ee

d 
(V

ou
ch

er
 R

A
L-

20
11

-0
12

)

Page 28 of 28



BOAT SURVEY:
Lake Upper Scott Flowage (a.k.a. Park Mill Impoundment)
County Marinette County, WI & Menominee County, MI
WBIC 609400
Date of Survey 8/1/2011 - 8/19/2011
Field Crew RICK LOEFFLER & CORWIN MIRR

Nearest Point Species seen, habitat information
8 Schoenoplectus tabernaemontani, Softstem bulrush
13 Carex comosa, Bottle brush sedge
13 Lythrum salicaria, Purple loosestrife - see comment 1

13 & 582 Unidentified - (possibly Iris versicolor, Northern blue flag) - see comment 2
13 Unidentified - (possibly Juncus effusus, soft rush) - see comment 3
29 Typha sp., Cattail
38 Scirpus atrovirens, black bulrush

441 Acorus americanus, Sweet-flag
635 Phalaris arundinacea, Reed canary grass - see comment 4

ADDITIONAL COMMENTS
1. Lythrum salicaria, Purple loosestrife - PKML PL014, Gallerucella beetle damage, beetles, 
larvae, and eggs confirmed at this location, took photos
2. Unidentified - (possibly Iris versicolor, Northern blue flag) - unable to collect specimen, not 
blooming, took photo of plant near point 13
3. Unidentified - (possibly Juncus effusus, soft rush) - unable to collect specimen, took photo 
of plant

4. On shore - private property - possibly out of survey boundary - unable to collect specimen.



INDIVIDUAL SPECIES STATS:
Name
County
WBIC
Date

Field Crew
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Ceratophyllum demersum, Coontail 61.48 45.18 12.78 0.02 150 1.27 4
Potamogeton zosteriformis, Flat-stem pondweed 44.26 32.53 9.20 0.01 108 1.02 21
Lemna trisulca, Forked duckweed 43.03 31.63 8.94 0.01 105 1.00 2
Spirodela polyrhiza, Large duckweed 41.80 30.72 8.69 0.01 102 1.00 11
Lemna minor, Small duckweed 41.39 30.42 8.60 0.01 101 1.00 12
Elodea canadensis, Common waterweed 40.57 29.82 8.43 0.01 99 1.07 11
Filamentous algae 40.16 29.52 98 1.02 5
Wolffia columbiana, Common watermeal 39.75 29.22 8.26 0.01 97 1.00 4
Vallisneria americana, Wild celery 30.74 22.59 6.39 0.00 75 1.00 5
Heteranthera dubia, Water star-grass 26.23 19.28 5.45 0.00 64 1.00 26
Nymphaea odorata, White water lily 12.70 9.34 2.64 0.00 31 1.00 95
Potamogeton strictifolius, Stiff pondweed 12.30 9.04 2.56 0.00 30 1.03 4
Potamogeton robbinsii, Fern pondweed 11.48 8.43 2.39 0.00 28 1.07 3
Myriophyllum spicatum,Eurasian water milfoil 9.43 6.93 1.96 0.00 23 1.00 32
Myriophyllum sibiricum, Northern water-milfoil 7.38 5.42 1.53 0.00 18 1.00 3
Potamogeton crispus,Curly-leaf pondweed 5.74 4.22 1.19 0.00 14 1.00 5
Ranunculus aquatilis, White water crowfoot 5.74 4.22 1.19 0.00 14 1.00
Potamogeton amplifolius, Large-leaf pondweed 5.33 3.92 1.11 0.00 13 1.00 24
Utricularia vulgaris, Common bladderwort 5.33 3.92 1.11 0.00 13 1.00 5
Aquatic moss 4.51 3.31 11 1.00
Potamogeton nodosus, Long-leaf pondweed 3.69 2.71 0.77 0.00 9 1.00 2
Ranunculus flabellaris, Yellow water crowfoot 3.69 2.71 0.77 0.00 9 1.00
Nitella sp., Nitella 3.28 2.41 0.68 0.00 8 1.00 1
Potamogeton pusillus, Small pondweed 2.87 2.11 0.60 0.00 7 1.00
Utricularia minor, Small bladderwort 2.46 1.81 0.51 0.00 6 1.00
Bidens beckii (formerly Megalodonta), Water marigold 2.05 1.51 0.43 0.00 5 1.00 8
Stuckenia pectinata, Sago pondweed 2.05 1.51 0.43 0.00 5 1.00 7
Potamogeton foliosus, Leafy pondweed 1.64 1.20 0.34 0.00 4 1.00 1
Potamogeton natans, Floating-leaf pondweed 1.64 1.20 0.34 0.00 4 1.00 2
Chara sp., Muskgrasses 1.23 0.90 0.26 0.00 3 1.00
Najas flexilis, Slender naiad 1.23 0.90 0.26 0.00 3 1.00 1
Nuphar variegata, Spatterdock 1.23 0.90 0.26 0.00 3 1.00 31
Potamogeton praelongus, White-stem pondweed 1.23 0.90 0.26 0.00 3 1.00 1
Ranunculus flammula, Creeping spearwort 1.23 0.90 0.26 0.00 3 1.00
Utricularia geminiscapa, Twin-stemmed bladderwort 1.23 0.90 0.26 0.00 3 1.00
Unidentified (Small?) Pondweed (Voucher RAL-2011-012) 1.23 0.90 0.26 0.00 3 1.00
Myriophyllum heterophyllum, Various-leaved water-milfoil 0.82 0.60 0.17 0.00 2 1.00 1
Potamogeton alpinus, Alpine pondweed 0.82 0.60 0.17 0.00 2 1.00
Potamogeton illinoensis, Illinois pondweed 0.82 0.60 0.17 0.00 2 1.00
Potamogeton oakesianus, Oakes' pondweed 0.82 0.60 0.17 0.00 2 1.00 3
Potamogeton richardsonii, Clasping-leaf pondweed 0.41 0.30 0.09 0.00 1 1.00 6
Sagittaria latifolia, Common arrowhead 0.41 0.30 0.09 0.00 1 1.00 1
Riccia fluitans, Slender riccia 0.41 0.30 1 1.00
Sium suave, Water parsnip (Voucher RAL-2011-034) 0.41 0.30 0.09 0.00 1 1.00
Sparganium eurycarpum, Common bur-reed 3
Zizania sp., Wild rice 3
Sparganium natans, Small bur-reed 2
Equisetum fluviatile, Water horsetail 1
Potamogeton epihydrus, Ribbon-leaf pondweed 1

Total vegetation 0.07 1.35

Acorus americanus, Sweet-flag Boat Survey
Carex comosa, Bottle brush sedge Boat Survey
Unidentified - (possibly Iris versicolor, Northern blue flag) Boat Survey
Unidentified - (possibly Juncus effusus, soft rush) Boat Survey
Lythrum salicaria, Purple loosestrife Boat Survey
Phalaris arundinacea, Reed canary grass Boat Survey
Schoenoplectus tabernaemontani, Softstem bulrush Boat Survey
Scirpus atrovirens, black bulrush Boat Survey
Typha sp., Cattail Boat Survey

RICK LOEFFLER & CORWIN MIRR

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011



SUMMARY STATS:
Lake Upper Scott Flowage (a.k.a. Park Mill Impoundment)
County Marinette County, WI & Menominee County, MI
WBIC 609400
Date of Survey 8/1/2011 - 8/19/2011
Field Crew RICK LOEFFLER & CORWIN MIRR

546
244
332

73.49
0.93

8
0

385
3.54
4.81
3.42
4.70

41
46

**SEE "MAX DEPTH GRAPH" WORKSHEET TO CONFIRM

Simpson Diversity Index
Maximum depth of plants (ft)** 

Species Richness 
Species Richness (including visuals)

Number of sites sampled using rake on Rope (R)
Number of sites sampled using rake on Pole (P)
Average number of all species per site (shallower than max depth)
Average number of all species per site (veg. sites only)
Average number of native species per site (shallower than max depth)
Average number of native species per site (veg. sites only)

Total number of sites visited
Total number of sites with vegetation
Total number of sites shallower than maximum depth of plants
Frequency of occurrence at sites shallower than maximum depth of plants



FLORISTIC QUALITY INDEX
Lake
County
WBIC 
Date
Field Crew

Species Common Name C species present=1
Bidens beckii Water marigold 8 1 8
Ceratophyllum demersum Coontail 3 1 3
Chara Muskgrasses 7 1 7
Elodea canadensis Common waterweed 3 1 3
Heteranthera dubia Water star-grass 6 1 6
Lemna minor Small duckweed 4 1 4
Lemna trisulca Forked duckweed 6 1 6
Myriophyllum heterophyllumVarious-leaved water-milfoi 7 1 7
Myriophyllum sibiricum Northern water-milfoil 6 1 6
Najas flexilis Slender naiad 6 1 6
Nitella Nitella 7 1 7
Nuphar variegata Spatterdock 6 1 6
Nymphaea odorata White water lily 6 1 6
Potamogeton alpinus Alpine pondweed 9 1 9
Potamogeton amplifolius Large-leaf pondweed 7 1 7
Potamogeton foliosus Leafy pondweed 6 1 6
Potamogeton illinoensis Illinois pondweed 6 1 6
Potamogeton natans Floating-leaf pondweed 5 1 5
Potamogeton nodosus Long-leaf pondweed 7 1 7
Potamogeton oakesianus Oakes' pondweed 10 1 10
Potamogeton praelongus White-stem pondweed 8 1 8
Potamogeton pusillus Small pondweed 7 1 7
Potamogeton richardsonii Clasping-leaf pondweed 5 1 5
Potamogeton robbinsii Fern pondweed 8 1 8
Potamogeton strictifolius Stiff pondweed 8 1 8
Potamogeton zosteriformis Flat-stem pondweed 6 1 6
Ranunculus aquatilis White water crowfoot 8 1 8
Ranunculus flabellaris Yellow water crowfoot 8 1 8
Ranunculus flammula Creeping spearwort 9 1 9
Riccia fluitans Slender riccia 7 1 7
Sagittaria latifolia Common arrowhead 3 1 3
Spirodela polyrhiza Large duckweed 5 1 5
Stuckenia pectinata Sago pondweed 3 1 3
Utricularia geminiscapa Twin-stemmed bladderwort 9 1 9
Utricularia minor Small bladderwort 10 1 10
Utricularia vulgaris Common bladderwort 7 1 7
Vallisneria americana Wild celery 6 1 6
Wolffia columbiana Common watermeal 5 1 5

N 38
mean C 6.5
FQI 40.06869102

CITATION: Nichols, SA. 1999. Floristic Quality Assessment of Wisconsin Lake Plant Communities with Example Applications. 
Journal of Lake and Reservoir Management, 15(2):133-141. 

CITATION: University of Wisconsin-Madison, 2001. Wisconsin Floristic Quality Assessment (WFQA). Retrived October 27, 2009 
from: http://www.botany.wisc.edu/WFQA.asp

Upper Scott Flowage (a.k.a. Park Mill Impoundment)
Marinette County, WI & Menominee County, MI

609400
8/1/2011 - 8/19/2011

RICK LOEFFLER & CORWIN MIRR
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APPENDIX B 
 

Eurasian Water Milfoil (EWM) 
Survey Data and Maps 
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Eurasian Watermilfoil Mat Information 13-01-30 CTM RAL PKML 2011 EWM Mat Information.xls

Project:
Date:
Crew: Datum: WGS 84

MAT Number Latitude Longitude Survey GPS Point Mat Acreage Comments
PKML 

EWM001
N45.11153  W87.66462 #984 8.18 First observed in 2011. Scattered plants on edge and center 

with medium density on upstream and downstream ends. 
Mixed with native plants and some CLP.

PKML 
EWM002

N45.11355 W87.66282 #676 15.37 First observed in 2011. Scattered plants on edge and center 
with medium density on upstream and downstream ends. 
Mixed with native plants and some CLP.

PKML 
EWM003

N45.11235 
N45.11324

W87.66775 
W87.66596

#673 & #674 3.59 First observed in 2011. Scattered plants on edge and center. 
Mixed with native plants and some CLP.

PKML 
EWM004

N45.12319  W87.67190 #716 1.68 First observed in 2011. Scattered plants on edge and center 
with medium density on east side and downstream end. 
Mixed with native plants and some CLP.

PKML 
EWM005

N45.10538 W87.66336 #691 0.002 First observed in 2011. Scattered plants entire mat 30' in 
diameter. Mixed with native plants.

PKML 
EWM006

N45.14757 W87.68736 #671 4.75 First observed in 2011. Scattered plants entire mat. Mixed 
with native plants.

PKML 
EWM007

N45.13798  W87.68050 #508 0.93 First observed in 2011. Scattered plants entire mat. Mixed 
with native plants.

PKML 
EWM008

N45.11405  
N45.11732

W87.67232 
W87.67371

#155 & #228 8.77 First observed in 2011. Scattered plants entire mat. Mixed 
with native plants and some CLP.

PKML 
EWM009

N45.12651 
N45.12811

 W87.67410 
W87.67327

#358 - #376 3.84 First observed in 2011. Scattered plants entire mat. Mixed 
with native plants.

8/1/2011 - 8/19/2011
RAL & CTM

Park Mill Impoundment (aka Upper Scott Flowage) #2744

Page 1 of 1
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APPENDIX C 
 

Curly Leaf Pondweed (CLP) 
Survey Data and Maps 
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Curly Leaf Pondweed Survey 13-01-20 CTM RAL PKML 2011 CLP Mat Information.xls

Project:
Date:
Crew: Datum: WGS 84

MAT Number Latitude Longitude Survey GPS Point Mat Acreage Comments
PKML CLP001 N45.11405  

N45.11732
W87.67232 
W87.67371

#155 & #228 6.56 Sparce plants mixed with native aquatics and Eurasian 
Watermilfoil

8/1/2011 - 8/19/2011
RAL & CTM

Park Mill Impoundment (aka Upper Scott Flowage) #2744

Page 1 of 1
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APPENDIX D 
 

Purple Loosestrife (PL) 
Survey Data and Maps 
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Purple Loosestrife Survey 13-01-30 CTM RAL PKML 2011 PL Survey.xls

Project:
Date:
Crew: Datum: WGS 84

GPS point Latitude Longitude Plant  Height Stand Area Beetle Damage Comments
PKML PL001 N45.13396 W87.66858 3' - 6' 3 plants None First observed in 2011. Blooming. No photos in 2011. No 

treatment in 2011. - 50' west of original WPT 665. 

PKML PL002 N45.12867 W87.67110 4' - 5' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL003 N45.13115 W87.67996 4' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL004 N45.12015 W87.67330 3' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL005 N45.14609  W87.68470 5' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL006 N45.13684 W87.67604 5' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL007 N45.13657 W87.67526 4' - 5' 4 plants None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Estimated location.

PKML PL008 N45.13539 W87.67354 4' 4 plants Unknown First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Estimated location.

PKML PL009 N45.13492 W87.67230 5' 1 plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Estimated location. (NW corner of culvert 
at Fairland Rd.

PKML PL010 N45.13449 W87.67140 4' - 5' 5 plants Unknown First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Estimated location.

PKML PL011 N45.13445 W87.67033 4' - 5' 2 plants Unknown First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Estimated location.

PKML PL012 N45.13346 W87.67005 2' - 4' 5 plants None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. On stump in water.

PKML PL013 N45.12270 W87.67102 4' 1 plant Light First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. Old cane.

8/1/2011 - 8/19/2011
RAL & CTM

Park Mill Impoundment (aka Upper Scott Flowage) #2744

Page 1 of 2



Purple Loosestrife Survey 13-01-30 CTM RAL PKML 2011 PL Survey.xls

Project:
Date:
Crew: Datum: WGS 84

GPS point Latitude Longitude Plant  Height Stand Area Beetle Damage Comments

8/1/2011 - 8/19/2011
RAL & CTM

Park Mill Impoundment (aka Upper Scott Flowage) #2744

PKML PL014 N45.10493 W87.66375 2' - 3' 2 plants Heavy First observed in 2011. Not blooming. Photos in 2011. No 
treatment in 2011. Beetles, eggs, and larve confirmed in 
2011. All plants stunted.

PKML PL015 N45.10503 W87.66779 1' - 6' >500 Plants 
Shorline ~220 
meters x 10 

meters

Light/Heavy First observed in 2011. Blooming. Photos in 2011. No 
treatment in 2011. Some plants stunted.

PKML PL016 N45.10671 W87.66325 4' - 5' 2 plants None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011.

PKML PL017 N45.10494 W87.66953 1' 1 Plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. On floating root mass.

PKML PL018 N45.12137 W87.67730 3' 1 Plant None First observed in 2011. Blooming. No photos in 2011. No 
treatment in 2011. On log.

PKML PL019 N45.12009 W87.67656 4' - 5' 1 Plant None First observed in 2011. Blooming. Photos in 2011. No 
treatment in 2011. On stump.

PKML PL020 N45.11921 W87.67668 3' 1 Plant None First observed in 2011. Blooming. Photos in 2011. No 
treatment in 2011. On log near duck blinds.

PKML PL021 N45.11738 W87.67624 1' - 6' >500 Plants 
Shorline ~900 
meters x 10 

meters

Unknown First observed in 2011. Some plants blooming. No photos in 
2011. No treatment in 2011. Near duck blinds.

PKML PL022 N45.11798 W87.67580 1' - 5' 100 - 200 Plants 
On Small Island 
~30 meters x 10 

meters

Light/Medium First observed in 2011. Some plants blooming. Photos in 
2011. No treatment in 2011. Some plants stunted. Old cane. 
On small island.

Page 2 of 2
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APPENDIX E 
 

Recommended Baseline Monitoring 
of Aquatic Plants in Wisconsin: 

Sampling Design, Field and Laboratory 
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EXECUTIVE SUMMARY 
 
We outline a baseline monitoring protocol designed to quantitatively assess the distribution and 
abundance of aquatic plants in lake ecosystems.  This protocol employs a point-intercept 
sampling design, with sites located on a geo-referenced sampling grid placed over the entire lake.  
At each site, the aquatic plant community is surveyed from a boat with a rake sampler to 
characterize species presence and rake fullness.  In addition, a qualitative survey is 
recommended to map obvious species and augment the species list generated through 
quantitative sampling.  Application of this methodology allows: 1) assessment of the frequencies 
of occurrence of different plant species, as well as estimates of species richness, abundance, and 
maximum depth of plant colonization; and 2) comparisons of aquatic plant variables over time 
and among lakes.  This document contains complete instructions for conducting a baseline 
aquatic plant survey, including details on obtaining an electronic file of site coordinates, 
uploading site coordinates into a Global Positioning System (GPS) receiver, conducting field 
work, entering data, working with data summaries, processing voucher specimens, and provides 
example applications of the collected data.  Final products from each baseline survey will 
include: 1) raw data from the quantitative survey which provides individual site-by-site species 
distribution and rake fullness data, 2) summary statistics useful in characterizing and comparing 
populations, 3) additional species observations from the general qualitative survey, and 4) 
voucher specimens cataloguing species presence.  All electronic data should be sent for long-
term record-keeping to the WDNR (DNRBaselineAquaticPlants@wisconsin.gov).
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INTRODUCTION 
 
In lake ecosystems, the aquatic plant community serves as critical habitat and nursery for fish 
and other animals, a source of oxygen for all organisms, a refuge for prey as well as a foraging 
area for predators, a buffer against erosion and sediment resuspension from both waves and 
shoreline inputs, and can significantly contribute to overall lake primary productivity.  Over the 
past several decades, losses of or changes in assemblages of native submersed aquatic vegetation 
has been a reoccurring phenomenon due to a relatively limited number of factors.  Repeatedly, 
changes in landscapes and atmospheric conditions as a result of human activities have 
increasingly affected the ecology of adjacent aquatic systems, including aquatic plant 
communities.  In addition, in-lake aquatic plant management activities have increased due to the 
increasing spread of invasive exotic plants1. 
 
The Wisconsin Department of Natural Resources (WDNR) is charged with protecting and 
enhancing the state’s natural resources, including lake ecosystems.  Given the many ecosystem 
services associated with aquatic plant communities as well as the recent threats to native species, 
it has become increasingly important to develop monitoring techniques to support science-based 
decision-making for effectively managing lake ecosystems.  In this document, we present a 
quantitative, replicable monitoring protocol.  Standardized, quantitative and replicable data are 
an essential part of strategic lake management for three reasons.  First, good data allows us to 
better understand each individual lake; we can use survey data to produce detailed lake maps that 
show the locations of native, rare, or exotic plant species.  Data can then be used as a baseline 
against which any changes in a lake associated with water clarity, exotic species introduction, 
water level, or lake management activity can be compared.  Second, good data helps direct 
management by taking the conflict and guesswork out of planning.  Aquatic plant management 
requires weighing a number of potential management options, some of which can be very costly 
or extensive.  Baseline data allows lake groups to identify the most appropriate management 
options and design the best possible management plan.  Additionally, by conducting quantitative 
comparisons between the aquatic plant communities before and after management actions, lake 
groups and managers may evaluate whether or not management goals were achieved.  Third, by 
compiling and comparing survey information on lakes statewide, we are able to identify regional 
trends and refine our understanding of aquatic plant populations on a broader scale in both space 
and time. 
 
 
SURVEY OBJECTIVE 
 
In this document, we outline a baseline monitoring protocol designed to assess aquatic plant 
communities on a whole-lake scale.  We recommend a formal quantitative survey conducted at 
pre-determined sampling locations distributed evenly throughout the lake, accompanied by a 
general qualitative survey to map obvious species and augment the species list generated through 
the quantitative survey.  Our primary goals in adopting this methodology are to: 

                                                 
1 Knight, S., and J. Hauxwell. 2009. Distribution and abundance of aquatic plants- human impacts. In:  G. Likens 

(editor-in-chief), Encyclopedia of Inland Waters. Elsevier, Oxford, United Kingdom. 
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1) Collect quantitative data describing the frequencies of occurrence of different plant species, as 
well as estimates of species richness, abundance, and maximum depth of plant colonization for 
use in developing various management plans; and  
 
2) Use the data to statistically compare aquatic plant variables over time and among lakes.   
 
The importance of a statewide standardized protocol is that observed differences in a lake’s 
plant community can be attributed to actual changes in the community over time, without the 
confounding variation that results from different field workers employing different sampling 
techniques. 
 
The quantitative survey employs a point-intercept sampling design, adapted from terrestrial 
methods, with sites located on a geo-referenced sampling grid placed over the entire lake.  At 
each site, the aquatic plant community is surveyed from a boat with a rake sampler to 
characterize species presence and rake fullness ratings.  Although the presence/absence data 
cannot be used to estimate biomass or percent cover, it is less sensitive to interannual or seasonal 
variations in plant abundance2.  The method is also relatively rapid and cost-effective and can be 
used on the large scale to collect baseline data and statistically compare communities over 
time2,3.  In summary, it has the following attributes for estimation of aquatic plant distribution 
and abundance: 
 

• Systematic, quantitative, and replicable 
• Appropriate for lakes that vary in depth, size, region, shoreline complexity, and 

vegetation distribution 
• Evenly spaced distribution of sites results in a good coverage of the entire lake, 

precluding the random exclusion of niche habitats 
• Procedural simplicity 
• Inexpensive implementation 
• Results are easily analyzed with scientifically rigorous statistical methods 
• Spatial data preserved and can be mapped for both the managers’ use and for clearly 

communicating distributional data with the public 
 
These guidelines are intended to work on most lakes.  However, modifications may be required 
if a lake is uniquely shaped so that a uniform distribution of points isn’t representative (long, 
skinny lake shape), or if obtaining rake samples is difficult due to substrate (rocky/cobble 
bottom).   
 
Please note that these are “baseline” recommendations.  Additional monitoring activities may 
be warranted if the goal is to assess a specific management activity.  For example, to gauge the 
ability of chemical spot-treatments to control relatively small stands of an exotic species in a 

                                                 
2 Madsen, J.D. 1999. Point intercept and line intercept methods for aquatic plant management. Aquatic plant control 

technical note MI-02. Army Engineer Waterways Experiment Station, Vicksburg, MS. 
3 Dodd-Williams, L., G.O. Dick, R.M. Smart and C.S. Owens. 2008. Point Intercept and Surface Observation GPS 

(SOG): A Comparison of Survey Methods – Lake Gaston, NC/VA. ERDC/TN APCRP-EA-19. Vicksburg, 
MS: U.S. Army Engineer Research and Development Center 
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relatively large lake, we recommend additional mapping of the beds following the pre- and post-
treatment protocol available in Appendix D of the Aquatic Plant Management guide4. 
 
Unlike the procedures used by the Citizen-Based Lake Monitoring Network, this protocol is not 
designed for most volunteers.  The protocol requires at least one of the field workers be an 
experienced plant taxonomist and able to identify most plant species in the field.  Less 
experienced volunteers may be able to help with data recording and navigation, but without the 
help of a professional aquatic ecologist, volunteers may not be able to conduct an entire plant 
survey without a significant degree of training or study.  
 
 
SURVEY OVERVIEW 
 
Sampling Sites 
 
This method employs a point-intercept 
design in which a grid of sampling sites is 
distributed evenly over the entire lake 
surface (Figure 1).  Lake organizations or 
individuals can request an electronic file of 
survey sites by contacting the WDNR Lake 
Coordinator from their region (see 
Appendix 1) with the lake name and 
county, as well as the town, range and 
section (TRS) or water body identification 
code (WBIC).  Please make requests well 
in advance of planned field work to allow 
WDNR staff sufficient time for map 
creation (recommend at least 1 month).  
WDNR staff will determine the number of 
sites and grid resolution based on the 
estimated size of the littoral zone (the area in 
which plants grow) and shape of the lake.  
Grids will be scaled to produce a greater 
number of sites on lakes that are larger and have more complex shorelines.  Lakes with a narrow 
littoral zone may be assigned a comparatively high number of sampling sites to achieve 
sufficient survey coverage.  Once created, the sampling map (Figure 1) and an associated GPS 
text file containing the latitude and longitude information associated with each sample site will 
be provided electronically by the WDNR.  
 
Timing of Sampling 
 
Surveys should be conducted between early July and mid August.  Although certain plant 
community parameters (such as rake fullness and biomass) can change over the course of the 
                                                 
4 Aquatic Plant Treatment Evaluation. http://www.uwsp.edu/cnr/uwexlakes/ecology/APM/Appendix-D.pdf 
 

Figure 1: The point-intercept grid for Kathan Lake, Oneida County, WI, 
with 203 sampling sites. 
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growing season, presence/absence data is less sensitive to seasonal variation2; presence can often 
be detected throughout the season.  For many species, including Eurasian water milfoil (EWM), 
plant biomass and density may increase as the season progresses, whereas some species like 
curly-leaf pondweed (CLP), senesce much earlier in the sampling season.  Rake fullness data for 
these species must be interpreted carefully with the sampling date in mind.  If early-senescing 
species such as CLP are targets of management actions, please contact the WDNR Lake 
Coordinator in your region to coordinate the best possible sampling time. 
 
Time Spent Sampling 
 
Depending on the size of the lake, a survey may be completed in a few hours, or it may take 
several days.  Ideally, a crew spends one-half to three minutes per sample site; however, this may 
vary depending on the following factors: 

 
• Distance between sample sites 
• Weather (i.e. wind, rain, etc.) 
• Rake fullness 
• Ease of navigation 
• Experience; less experienced field 

workers may take longer to 
identify unfamiliar plants.  
However, most field workers have 
found that the time spent per site 
drops dramatically with 
experience.  Others have reported 
their speed increasing greatly with 
a few hours of training.  

 
 
PREPARING FOR FIELD WORK 
 
Field Gear 
 
Necessary equipment: 

• Appropriate watercraft and all equipment required by state law 
• Double-sided sampling rake attached to a 15-ft (4.6m) pole 
• Weighted sampling rake attached to a 40-ft (12m) rope 
• Handheld GPS receiver with WDNR sample sites loaded 
• Print-out of lake map with WDNR sample sites 
• Print-out of WDNR field datasheets on waterproof paper 
• Pencils 
• Sealable storage bags for voucher specimens  
• Waterproof voucher sample labels  
• Cooler(s) with ice for storing voucher specimens 
• Depth finder 
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Helpful, but not required:  
• Trolling motor for reaching shallow sites 
• Bathymetric map 
• Plant ID references or guides to aid in plant identification 
• Hand lens to aid in plant identification 
• Digital camera for plant specimens or field pictures 
• Underwater video camera for viewing the maximum depth of plant colonization 

 
Loading Sample Site Locations onto the GPS Receiver 
 
Detailed instructions on loading sample site locations onto the GPS receiver depend greatly on 
the type of GPS receiver as well as the software used to translate site location from the text file 
to “waypoints” in the receiver.  The WDNR commonly utilizes Garmin 76 model GPS receivers 
and the WDNR Garmin GPS Standalone Tool software.  The WDNR Standalone Tool is only 
available to WDNR employees, and only works with Garmin GPS receivers.  The Minnesota 
Garmin GPS Tool and appropriate guidance documents are available to the public and can be 
found online at the Minnesota DNR internet site5.  The two programs are similar; their chief 
difference is that the Minnesota tool requires the GPS text file to be comma-delimited instead of 
tab-delimited.  Procedures for other GPS models with a Wide Area Augmentation System 
(WAAS-capability) may be used; please refer to the manufacturer’s instructions for details on 
uploading site locations.   
 
Please note that storage capability varies by GPS model.  Some GPS receivers are unable to store 
the large numbers of data sites required in some surveys.  In the event that the number of 
sampling sites exceeds your receiver's storage capacity, the text file containing the survey site 
information can be split into smaller text files.  You will then be able to upload successive files 
of sites as needed or work from multiple receivers in the field. 
 
The instructions below describe how WDNR employees can use the WDNR Garmin Standalone 
Tool software to load sample site locations, or “waypoints,” onto a Garmin 76 model GPS 
receiver. 
 
To upload waypoints from a GPS text file to the GPS receiver, you will need:  
 

• PC/laptop with WDNR Garmin GPS Tool. Your IT administrator can help you obtain 
and install the software. 

 
• GPS text file (.txt extension). A tab-delimited text file containing the sample sites and 

their geographical information.   
 
• A Garmin 76 model GPS receiver with external data port. 
 

                                                 
5 Available online at: http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html 
(accessed September, 2009) 
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• PC interface cable (with USB or 9-pin serial connector).  Can be purchased online at 
http://www.garmin.com 

 
Step 1: Set GPS to the “Simulating GPS” Mode 
 
Operating the receiver in “Simulating GPS” mode prevents the GPS receiver from trying to 
acquire a satellite signal indoors. 
 

1. Press and hold the red [ON/OFF] button for two seconds to turn the GPS receiver on. 
 
2. Press [PAGE] to navigate through the welcome screens until the “Acquiring Satellites” 

page is visible.  

 
3. Press the [MENU] button, select “Start Simulator”, and press [ENTER]; the screen 

heading should now read “Simulating GPS.” 
 

Step 2: Set Serial Data Format (this setting will not have to be re-set upon each use) 
 
Set the serial data format on the Garmin 76 receiver to GARMIN prior to transferring data.  
Failure to set the serial data format to GARMIN will cause a communication error. 
 

1. Press the [MENU] button twice to reach the main menu, use the rocker key to select 
“Setup”, and then press [ENTER]. 
 

2. Use the rocker key to scroll left or right until the “Interface” tab is highlighted.  Use the 
rocker key to scroll down to highlight the drop-down box and press [ENTER].  
 

3. A menu will appear; select “GARMIN” and press [ENTER].  Press [QUIT] twice to exit 
the menu. 

 
Step 3: Plug in the PC Interface Cable 
 

1. The GPS receiver should be on and in simulation mode. 
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2. Plug the 9-pin serial connector cable into COM port #1 on your PC.  If port #1 is in use, 
plug into the next available port and note the port number. The newest version of the 
WDNR Garmin GPS Tool (ver. 8.2.8) supports USB connectivity as an alternate to COM 
port connection. 
 

3. Plug the round end of the PC interface cable into the external data/auxiliary power port 
under the rubber panel on the back of the GPS receiver. 

 
Step 4: Load the GPS text file into the WDNR Garmin Standalone Tool 
 

1. Open the WDNR Garmin GPS Tool file on your computer. Select:  

File > Load > Waypoints From > Lat-Long GPS Text File.  

 

2. Navigate to and select the appropriate GPS text file and select OK.  The waypoints will 
be visible in the Tool’s status bar. 

 

3. If necessary, you can view and edit waypoints by clicking the [Advanced] button on the 
WDNR Garmin GPS Tool. 

 

4. Troubleshooting COM-enabled setups 

a. Check that the correct COM port is selected in the WDNR Garmin GPS tool. 

i. GPS > Assign Port > select correct port # 

b. Check that the baud rate matches that of the GPS receiver. 

i. GPS > Assign Port >Baud Rate > 9600 

ii. A Garmin 76 receiver will transfer at 9600 bits per second  
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c. Check that the serial data format is set to “GARMIN” (see Step 2). 

d. If your problem persists, please consult your GPS unit’s user’s manual. 
 

Step 5: Upload Waypoint Data from the WDNR Garmin GPS Tool to the GPS receiver 
 

1. In the menu bar, select: Waypoint > Upload  
 

 
2. A pop-up window will indicate the completion of a successful upload. Click OK.  

 
3. Check that the uploaded waypoints are visible on the GPS receiver: press [MENU] twice 

to get to the main menu, select “Points”, press [ENTER], select “Waypoints”, and press 
[ENTER]. 

 
4. Troubleshooting   

a. Storage capability varies by GPS model.  In the event that the number of sampling 
sites exceeds your receiver's storage capacity, the text file containing the survey 
site information can be split into smaller text files.  You will then be able to 
upload successive files as needed or work from multiple receivers in the field. 

b. For more help, please refer to the appropriate online documentation or user’s 
manuals. 
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Printing Datasheets 
 
The form used for recording data can be found on the tab labeled “FIELD SHEET” in the 
Aquatic Plant Survey Data Workbook, downloadable from the University of Wisconsin 
Extension website (http://www.uwsp.edu/cnr/uwexlakes/ecology/APM/Appendix-C.xls).  Print 
the field sheet (waterproof paper recommended), using the “Print Area > Set Print Area” 
function under the “File” menu to set the appropriate number of rows to print.  Under Header 
(View > Header and Footer > Custom Header) record lake name, Waterbody Identification Code 
(WBIC), county and survey date. 
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Constructing the Rake Samplers 
 
The rake samplers are each constructed of two rake heads welded together, bar-to-bar, to form a 
double-sided rake head.  The rake head is 13.8 inches (35 centimeters) long, with approximately 
14 tines on each side.  For use in shallow waters, mount a double-sided rake head to a pole that 
has the capability to extend to 15 feet (4.6 meters).  For use in deeper waters, attach a second 
double-sided rake head to a rope; this rake head should also be weighted (Figure 2). 
 

 

 
Pole Sampler 
 
To make the pole samplers shown in 
the photographs, we removed the 
handles from 2 standard bow rakes 
(available at most hardware stores), and 
welded the rake heads together bar-to-
bar.  We mounted the rake head to an 
8-foot (telescoping to 15.5 feet) pool 
skimmer handle purchased from a 
supply store (left, $50).  For an even 
sturdier sampler we purchased an 
aluminum Co-Handle from Duraframe 
Dipnet and designed a rake pole which 
attaches and detaches into 3 sections 
(right, $200).  For depth recording, 
mark the rake handle in one-foot 
increments.  Electrical tape marked 
with permanent marker, then covered 
with a length of clear packing tape 
works well and holds up over time. 

 
Rope Sampler 
 
A similar rake head should be 
constructed and attached to a 40-foot-
long rope or anchor line.  In order to 
ensure a quick vertical descent to the 
lake bottom, attach a light weight (~5 
lb) to the rake head, away from the 
tines.  The rope sampler pictured here 
has a short piece of steel tubing welded 
to the rake head to serve as a handle 
through which 45 feet of rope is 
attached. 
 

 
Figure 2:  Examples of sampling rakes used during surveys. 
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COLLECTING AND RECORDING FIELD DATA  
 
Using the Rake Samplers 
 
Collect one rake sample per sample site. 
 
In water shallower than 15 feet deep, use the pole sampler.  
At each sample site, lower the rake straight through the water 
column to rest lightly on the bottom, twist the rake around 
twice, and then pull the rake straight out of the water. 
 
In water deeper than 15 feet, drop the rope sampler straight 
into the water alongside the boat, drag the rake along the 
sediment surface for approximately one foot (0.3 m), and 
then pull the rake to the surface. 
 
A large tray or bin may be used to aid in processing the entire sample.   
 
Navigating to Sites 
 
Accuracy 
 
The location reported by the GPS receiver has an element of 
error that varies under different conditions.  The total error from 
the GPS and your navigational error combined should not exceed 
half of the sampling resolution.  Therefore, when sampling with 
a Garmin 76 receiver, navigate at no greater than an 80-foot 
zoom level and aim to completely cover the sampling site with 
the arrow.  At 80-foot zoom, the locator arrow shown on the 
screen represents approximately 25 feet in length.  In order to 
sample with acceptable accuracy, the arrow must completely 
cover the sample site on screen.  At coarser zoom levels, because 
the size of the arrow remains constant, the boat may be more 
distant from the site even though the arrow completely covers the 
site.  You can use a lower zoom level (120-feet is appropriate) in 
order to travel from site to site, but as you approach the target 
site, you must confirm your location at using at least the 80-ft 
zoom resolution to ensure you are sampling with acceptable 
accuracy. 
 
Determining Maximum Depth of Plant Colonization 
 
When sampling, you will have to determine the maximum depth at which the plants are rooted.  
The maximum depth of colonization (MDC) can vary greatly among lakes, from just a few feet 
to as deep as the physiological requirements of a species will allow.  When sampling a line of 
sites heading from shore out to deep water, take samples until plants are no longer found on the 
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rake.  Continue sampling at least two sites 
deeper to ensure you sampled well over the 
maximum depth of colonization.  If no 
plants are found at these sites, simply record 
the depth, sampling tool used, and dominant 
sediment type.  Leave the rake fullness and 
species information blank.  Depending on 
the lake bathymetry, you may choose to 
continue down the same row to the other 
side of the lake.  Use a depth finder and 
begin sampling again when the depth 
reaches that of the last (no plant) site 
sampled.  Alternatively, if the rows are very 
long, you may choose to move over to the 
next row and sample sites back into shore, 
working back and forth along the shoreline and around the lake.  However, if the second row is 
shallower than the first, be sure to start sampling sufficiently far from shore so that the depth is 
similar to that at which you stopped sampling in the first row.  By sampling in this way, over 
time you will begin to hone in on the maximum depth of plant colonization. 
 
After working several rows crossing the edge of the littoral zone, estimate the maximum depth of 
colonization (e.g. 20 feet) and only continue to sample deeper sites within 6 feet of this 
estimation (all sites ≤ 26 feet).  As you complete more rows and gain confidence in your 
estimation, you can then begin to gradually omit sampling depths that are too deep for plants to 
grow.  Once you have sampled the deep end of your estimated maximum depth of colonization 
(i.e. 26 feet) at least three times and have not found any plants, then you can discontinue 
sampling at anything deeper, but continue to sample any sites shallower (≤ 25 feet).  If you then 
sample a shallower depth three times (i.e. 25 feet) and find no plants at any of those sites, you 
may now discontinue sampling at these deeper sites and only sample sites shallower than this 
new sampling depth (≤ 24 feet).  Continue to successively eliminate shallower depths in 
sequence until you establish the maximum depth of colonization.  To account for patchiness and 
other sources of variation, never narrow the sampling window to less than 1.5 feet of the 
estimated maximum depth of colonization.  Use your best judgment when eliminating depths, 
and remember that plant distribution may be uneven and that different areas of a single lake may 
have plants growing relatively deeper or shallower.  It is good practice to err on the side of 
oversampling. 
 
Recording Data 
 
Completing the Field Sheet 

 
1.  General site information 

Complete the top portion of the “Field Sheet” 
with the lake name, county, WBIC, date, 
names of observers, and how many hours each 
person worked during the survey. 
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2.  Site number 
Each site location is numbered sequentially.  Each site number will have one row of data 
on the “Field Sheet.” 

 
3.  Depth 

Measure and record the depth to the nearest half-foot increment at each site sampled, 
regardless of whether vegetation is present.  The pole mounted rake and rope sampler 
should be marked to measure the depth of water at a sample site.  However, a variety of 
options exist for taking depth measurements, including sonar handheld depth finders 
(trigger models) and boat-mounted depth finders.  If you are using a depth finder, it is 
useful to know that the accuracy may decrease greatly in densely vegetated areas.  Depth 
finders sometimes report the depth to the top of the vegetation instead of to the sediment 
surface.  In most cases, it is best to use depth markings on a pole-mounted rake for 
shallow sites. 

 
4.  Dominant sediment type 

At each sample site, record the dominant sediment type based on how the rake feels when 
in contact with the sediment surface as: mucky (M), sandy (S), or rocky (R). 

 
5.  Pole vs. Rope 

Record whether the pole (P) mounted rake or the rake-on-a-rope (R) was used to take the 
sample. 

 
6.  Rake fullness 

At each site, after pulling the rake from the water record the overall rake fullness rating 
that best estimates the total coverage of plants on the rake (1 - few, 2 - moderate, 3 - 
abundant; see Figure 3).  Also identify the different species present on the rake and 
record a separate rake fullness rating for each.  Account for plant parts that dangle or trail 
from the rake tines as if they were fully wrapped around the rake head.  The rake may 
dislodge plants that will float to the surface, especially short rosette species not easily 
caught in the tines.  Include the rake fullness rating for plants dislodged and floating but 
not collected on the rake.  Record rake fullness ratings for filamentous algae, aquatic 
moss, freshwater sponges, and liverworts, but do not include these ratings when 
determining the overall rake fullness rating.  While at a site, perform a brief visual scan.  
If you observe any species within 6 feet (2m) of the sample site, but not collected with 
the rake, record these species as observed visually (“V”) on the field sheet.  These species 
will be included in total number of species observed. 
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Fullness 
Rating Coverage Description 

 
 
1 

 

Only few plants. There 
are not enough plants 
to entirely cover the 
length of the rake head 
in a single layer. 

 
 
 
2 

 

 

There are enough 
plants to cover the 
length of the rake head 
in a single layer, but 
not enough to fully 
cover the tines. 

 
 
3 

The rake is completely 
covered and tines are 
not visible. 

 
Figure 3: Illustration of rake fullness ratings used during the survey. 

 
7.  Species names 

Note that the field datasheet does not include any species names, except for EWM 
(Eurasian water milfoil) and CLP (Curly-leaf pondweed).  The sampling crew must write 
the species name in subsequent columns the first time that species is encountered.  Names 
must be re-written on successive field sheets as they are encountered.  You may use 
common or Latin names, but be sure there is no ambiguity in the name that will present 
problems during data entry.  The use of standard abbreviations can greatly shorten this 
process.  It is generally safe to shorten the names to include the first three letters of the 
genus name followed by the first three letters of the species name (i.e. Ceratophyllum 
demersum = CerDem). 

 
8.  Inaccessible sites 

It may be impossible or unsafe to reach some sample sites.  Where the water is very 
shallow, rocks are present, or dense plant growth prevents navigation, field workers 
should attempt to access the site as long as doing so is safe and relatively practical.  It is 
often possible to reach difficult sites by using oars or poling; however, keep safety in 
mind and practice good judgment.  Do not get out and drag the boat through mucky 
sediment to reach a site.  If the sampling site is shallow but the substrate is firm, you may 
be able to walk to the site from shore or from the boat.  If you cannot access a site, leave 
the depth blank and record the appropriate comment on the field datasheet from the list 
below.  Remember to also transfer these to the “Comments” column of the ENTRY sheet 
(see data entry section): 
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a. NONNAVIGABLE (PLANTS) 
1. Sample site cannot be accessed due to thick plant growth. 
2. Aquatic plants that are visible within 6 feet of a non-navigable sample site (e.g. water 

lilies, cattails, bulrushes, etc.) should be recorded as visuals (V) on the datasheet. 
 
b. TERRESTRIAL 
1. Sample site occurs on land (including islands). 
2. Aquatic plants visible within 6 feet of a terrestrial sample site (e.g. water lilies, cattails, 

bulrushes, etc.) may be included in the general boat survey list, but should not be marked 
as visuals (V) on the datasheet.   

3. Only species rooted in water should be recorded as present or as part of the boat survey. 
 
c. SHALLOW 
1. Sample site is in water that is too shallow to allow access. 
2. Aquatic plants that are visible within 6 feet of a shallow sample site should be recorded as 

visuals (V) on the datasheet. 
 
d. ROCKS 
1. Sample site is inaccessible due to the presence of rocks. 
 
e. DOCK 
1. Sample site is inaccessible due to the presence of a dock or pier. 
 
f. SWIM AREA 
1. Sample site is inaccessible due to the presence of a designated swimming area. 
 
g. TEMPORARY OBSTACLE 
1. Sample site is inaccessible due to the presence of a temporary obstacle such as a boater, 

swimmer, raft, loon, etc.  
2. If possible, try to revisit this site later on during the survey once the temporary obstacle has 

moved. 
 
h. NO INFORMATION 
1. No information is available about the sample site because it was not traveled to 

(inaccessible channel, accidently omitted during survey, skipped due to time constraints, 
etc.). 

 
i. OTHER 
1. Site was not sampled for another reason; please provide a brief description.  

 
9.  Filling Out the Boat Survey Datasheet 

Often there will be localized occurrences of certain species (e.g., floating-leaf or 
emergent species) that are missed by the point-intercept grid.  For areas that are outside 
the grid or in between sampling sites, record the name of the plant and the closest site to 
the plant.  This information will be entered into the “BOAT SURVEY” section of the 
data entry file.  Emergent near-shore vegetation should only be recorded if it’s rooted in 
water.   
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Collecting and Identifying Voucher Samples 
 
Voucher each plant species for verification and identification.  You can often use plants collected 
on the rake as vouchers.  However, if the sample is of poor quality or lacks reproductive 
structures, attempt to collect a better specimen.  If a better specimen is unavailable, voucher and 
press what you are able to collect.  Remember that the more material collected, the easier 
identification will be.  Whenever possible, collect at least two specimens, and include 
reproductive material such as seeds, flowers, fruit, roots, etc.  Place the voucher plant into a re-
sealable plastic bag with a waterproof voucher label.  The voucher label should include the 
species name, or in the case of unknown species, a unique identifier, the lake name, county, 
sample site, sediment type, collector’s name, and the date.  Additional information about habitat 
or co-occurring species may also be included on the tag.  Place all specimens in a cooler for 
transport to the lab.  See below, “Pressing Plants” for instructions once back at the laboratory. 
 
Plant Identification and Troublesome Taxa 

 
1.  Plants should be identified to species whenever possible.  Certain genera, including 
Carex, Sparganium, and Sagittaria must be flowering and/or fruiting to confirm 
identification and may not be identifiable to species without 
these parts. 

 
2.  Non-angiosperms such as Chara or Nitella are identified to 
genus only.  Often, Isoetes can be identified to species by 
looking at spores, if present.  Filamentous algae, aquatic moss, 
and freshwater sponge can be referred to simply as algae, 
moss, and sponge. 

 
3.  If a plant cannot be identified in the field, place the two 
voucher specimens in a re-sealable bag with a separate 
voucher label.  Take these specimens back to the lab to verify 
the identity.  The label should include a unique identifier, lake, 
county, the sample site number, and sediment type.  The 
presence and fullness of the species should be recorded on the 
field datasheet under the same unique identifier name listed on 
the voucher label. 

 
4.  In the lab, try to identify the plant using plant identification 
keys and a stereo microscope.  If you are still uncertain of the 
identity of the plant, contact a DNR biologist in your region to help with identification.  Do 
not send specimens to an expert until you notify them of your intended shipment and they 
have instructed you to do so.  Once the plant is identified, record this information so that the 
correct identification is used during data entry. 
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ENTERING DATA ELECTRONICALLY 
 
Worksheet Descriptions and Instructions 
 
The Aquatic Plant Survey Data Workbook 
(http://www.uwsp.edu/cnr/uwexlakes/ecology/APM/Appendix-C.xls) contains eight worksheets:  
 

 
 

1. READ ME 
 
Provide a brief description of the six other worksheets included in the workbook. 

 
2.  FIELD SHEET 

 
The FIELD SHEET should be printed on waterproof paper for recording the field data. 

 
3.  ENTRY 

 
a. There are many formulas embedded in the ENTRY sheet that allow for the 

statistical calculations on the STATS sheet.  Thus, DO NOT add or delete 
columns or rows on the ENTRY or STATS sheets.  

 
b. Data collected in the field is recorded on the FIELD SHEET and afterwards 

transferred to the electronic ENTRY sheet. 
 
c. Copy latitude and longitude information for the sample sites from the GPS text 

file and paste into the appropriate columns of the ENTRY sheet.  
 
d. Record the lake and county name, WBIC, survey date, and the names of the field 

workers. 
 
e. There is a column for comments on the ENTRY sheet.  Please use the 

standardized comments discussed on page 18 of this protocol. 
 
f. Species’ Latin names appear alphabetically in the first row of the spreadsheet.  

Species such as aquatic moss, freshwater sponge, filamentous algae, and 
liverworts are listed separately at the end of the alphabetical list.    

 
g. Additional species not already listed should be added in the columns at the end of 

the alphabetical list (sp1, sp2, etc.).  Any vouchered specimens that are awaiting 
ID confirmation should be entered here as well.  You should use the same unique 
voucher identifier established in the field to for ease of updating the information.  
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h. We strongly recommend double-checking the electronically entered data against 
the original field datasheets to ensure that no errors or omissions occurred during 
the entry process. 

 
4.  BOAT SURVEY 
 

a. Enter information on plants observed during the survey that were observed more 
than 6 feet away from a sample site. 

 
b. Additional comments about field conditions, known management activities, or 

other observations can also be recorded in this worksheet. 
 

5.  STATS 
 
The STATS worksheet automatically calculates summary statistics using the data entered 
into the ENTRY worksheet (see Appendix 2, Table 1).  There are several summary 
calculations including:  
 

a. Individual Species Statistics:  
i. Frequency of occurrence within vegetated areas (%): Number of sites 

at which a species was observed divided by the total number of vegetated 
sites.  Frequency of occurrence is sensitive to the number of sample sites 
included.  Including non-vegetated sites will lower the frequency of 
occurrence. 

ii. Frequency of occurrence at sites shallower than maximum depth of 
plants: Number of sites a species was observed at divided by the total 
number of sites shallower than maximum depth of plants. 

iii. Relative frequency (%): This is a proportional value that reflects the 
degree to which an individual species contributes to the sum total of all 
species observations.  The sum of the relative frequencies of all species is 
100%.  Relative frequency is not sensitive to whether all sampled sites, 
including non-vegetated sites, are included.  Relative frequency does not 
take into account aquatic moss, freshwater sponges, filamentous algae, or 
liverworts.    

iv. Relative frequency (squared): This value is only part of a calculation and 
is not used directly. 

v. Number of sites where a species was found: This is the sum of the 
number of sites at which a species was recorded on the rake. 

vi. Average rake fullness: Mean rake fullness rating, ranges from 1-3. 
vii. Number of visual sightings: This is the total number of times a plant was 

seen within 6 feet of the boat, but not collected on the rake. 
viii. Present (visual or collected): Automatically fills in “present” if the 

species was observed at a sample site. 
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b. Summary Statistics: 
i. Total number of sites visited: Total number of sites where depth was 

recorded, even if a rake sample was not taken.    
ii. Total number of sites with vegetation: Total number of sites where at 

least one plant was found on the rake. 
iii. Total number of sites shallower than maximum depth of plants: Total 

number of sites where the depth was less than or equal to the maximum 
depth at which plants were found.  This value is used for frequency of 
occurrence at sites shallower than maximum depth of plants. 

iv. Frequency of occurrence at sites shallower than maximum depth of 
plants: Number of times plants were recorded at a site divided by the total 
number of sites sampled that were shallower than the maximum depth of 
plants. 

v. Simpson’s Diversity Index: A nonparametric estimator of community 
heterogeneity.  It is based on relative frequency and thus is not sensitive to 
whether all sampled sites (including non-vegetated sites) are included.  
The closer the Simpson Diversity Index is to 1, the more diverse the 
community. 

vi. The maximum depth of plants: This is the depth of the deepest site 
sampled at which vegetation was present.  Please note that this value does 
not take into account aquatic moss, freshwater sponges, filamentous algae, 
or liverworts.  See “MAX DEPTH GRAPH” below for more information.   

vii. Number of sites sampled using rake on rope (R) 
viii. Number of sites sampled using rake on pole (P) 

ix. Average number of all species per site (shallower than max depth): 
Mean number of species found at sample sites which were less than or 
equal to the maximum depth of plant colonization.  

x. Average number of species per site (vegetated sites only): Mean 
number of species found at sample sites were vegetation was present.  

xi. Average number of native species per site (shallower than maximum 
depth): This does not include Eurasian water milfoil, Curly-leaf 
pondweed, Purple loosestrife, Spiny naiad, or Reed canary grass.  

xii. Average number of native species per site (vegetated sites only) 
xiii. Species richness: Total number of species observed not including visual 

sightings.  Please note that this value does not include aquatic moss, 
freshwater sponges, filamentous algae, or liverworts. 

xiv. Species richness (including visuals): Total number of species observed 
including visual sightings recorded within 6 feet of the sample site (but 
does not include additional species found during the boat survey).  

 
6.  MAX DEPTH GRAPH 

The maximum depth of colonization is an important metric to characterize accurately, as 
it can indicate changes in water clarity and water quality over time. This worksheet 
automatically displays a histogram of plant occurrences by water depth. Occasionally, 
unrooted plants floating in the water column are snagged by the rake, which can 
sometimes result in an inaccurate estimation of the maximum depth of colonization. It is 
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important to examine the reported maximum depth of plant colonization in order to detect 
potential outliers. As a general rule, a single plant occurrence reported at a site which is  
2 or more feet deeper than the next shallowest site with plants is considered an outlier, 
and should be excluded when determining the maximum depth of plant colonization (see 
Figure 4).    
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Figure 4: Distribution of plant occurrences versus water column depth.  The value circled in red is more than 2 
feet deeper than all other plants found during the survey, and is considered an outlier.  Outliers should be 
omitted when determining the maximum depth of plant colonization.    
 
It is necessary to delete the occurrence of this outlier from the ENTRY spreadsheet so 
that the automatically-calculated statistics will reflect the revised maximum depth of 
colonization.  To do this, locate the sampling point number on the ENTRY worksheet 
where the outlier was found.  Scroll across the row until you find the outlier to omit.  
Once you’ve located the cell with the outlier, press delete to clear the cell.  Right click on 
the cell and select “Insert Comment”.  Briefly describe the occurrence of the outlier and 
the reason for omitting it.  Follow the same steps with the overall rake fullness column, 
deleting out the contents of the cell and including a brief comment.  Please also include 
information regarding any omissions of outliers and revised MDC directly on the STATS 
spreadsheet, typing all comments in the space below “See Max Depth Graph Worksheet 
to Confirm”.    
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Figure 5: Top - Ceratophyllum demersum outlier at 31 feet (sampling point #118).  Bottom - C. demersum outlier 
at 31 feet deleted from both C. demersum and total rake fullness columns.  Brief descriptive comments should be 
inserted in cells where outliers have been deleted.   

 
7.  CALCULATE FQI 

This worksheet automatically calculates the Floristic Quality Index (FQI) based upon the 
data entered into the ENTRY worksheet.  The FQI metric is designed to evaluate the 
closeness of the flora in an area to that of undisturbed conditions6.  The species list 
considered in this calculation is that which Nichols6 originally considered, and the “C 
values” used in this spreadsheet reflect those currently accepted by the Wisconsin State 
Herbarium7.  Species are counted as being present only if they are collected on the rake at 
some point during the baseline survey.         
 

8. ARCGIS TEMPLATE 
This worksheet of truncated species names is used when creating plant distribution maps 
using ArcGIS 9.3.  See Appendix 3 for more information.    

 
 
 

                                                 
6 Nichols, S.A. 1999. Floristic Quality Assessment of Wisconsin Lake Plant Communities with Example 
Applications. Journal of Lake and Reservoir Management, 15(2):133-141.   
7 University of Wisconsin-Madison, 2001. Wisconsin Floristic Quality Assessment (WFQA). Retrieved October 27, 
2009 from: http://www.botany.wisc.edu/WFQA.asp 
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Saving the File 
 
Once the data is electronically entered into the Aquatic Plant Survey Data Workbook 
(http://www.uwsp.edu/cnr/uwexlakes/ecology/APM/Appendix-C.xls), please save the file with a 
name indicating the lake, county, WBIC, and year sampled.  The format we recommend is: 
Lake_County_WBIC_(year).xls.  For example, Lake Mendota sampled in 2009 would be named: 
Mendota_Dane_805400_(2009).xls 
 
Double-Checking the Data 
 
We strongly recommend double-checking the electronic data against the field sheet to catch any 
errors made during the entry process.   
 
Sending the Data 
 
Send the final electronic file to the WDNR via email 
(DNRBaselineAquaticPlants@wisconsin.gov).  There should be one file for each completed lake 
survey. 
 
Creation of Plant Distribution Maps 
 
Aquatic plant distribution maps can be easily created using the point-intercept data collected 
during the survey.  Instructions on how to create these maps can be found in Appendix 3 and 4.   
 
Statistical Analysis of Data 
 
Statistical comparisons of datasets can easily be analyzed between pre- and post-management 
activities or between two survey years by using a simple chi-square analysis.  The chi-square 
analysis is commonly used to examine whether or not there was a statistically significant change 
in the occurrence of a plant species between the survey years or after management activities have 
occurred.  The “Compute Pre-Post Data” worksheet (available at: 
http://www.uwsp.edu/cnr/uwexlakes/ecology/APM/Apendix-D1.xls), allows users to enter in the 
number of sites at which a species was recorded during each survey, and provides an output 
indicating whether or not differences reflect a statistically significant change in the plant 
community.         
 
 
PRESSING PLANTS – PREPARATION OF VOUCHER SPECIMENS 
 
“Floating” Specimens 
 
Because most aquatic plants, especially finely dissected specimens, tend to stick to paper as they 
dry, it is usually better to “float” the plant directly onto herbarium paper.  However, if the plant 
is large and robust, or not entirely aquatic (such as bulrushes, emergent sedges or pickerelweed) 
you can press the plant in newsprint.  
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1. Use a pencil to label the mounting paper with the plant name, geographic location, date 
collected, and serial code (a unique identifier in a series that identifies all specimens you 
have pressed; we use the initials of the presser followed by the year and a sequential 
number; i.e. AM2009-01).  Mount only one species per sheet, and do not cut herbarium 
sheets in half. 

 
2. Carefully rinse the plant so it is free of epiphyton, silt, and other debris. 
 
3. Fill a sink or tray with about one inch of water.  Slip the labeled mounting paper into the 

water. 
 
4. Float the plant in the water and arrange it onto the sheet. 
 
5. If the plant has fine leaflets, such as water milfoil or bladderwort, cut off one leaf and 

display it floated out onto the paper so that leaflet characteristics can be readily observed. 
 
6. The plant may be bent into a “V” or “W” or curled shape to fit on the sheet. 
 
7. Slowly lift the paper out of the water by one end.  Keeping the plant in place, let the 

water slowly drain off. 
 
8. Use a toothpick or probe to spread out plant parts for better display, making sure to 

expose identifiable characteristics such as stipules, sheaths or seeds. 
 
Pressing Specimens 

 
• Cover the plant with a sheet of 

waxed paper or plastic wrap if it is 
especially delicate (we recommend 
this technique especially for 
bladderworts and other fine, delicate 
species). 

• Place the specimen sheet inside folds 
of newspaper. 

• Place the newspaper between two 
sheets of blotting paper, and the 
blotting paper between two sheets of 
corrugated cardboard. 

• Place multiple specimens in a plant 
press.  Use rope or straps to 
compress plants to keep specimens 
flat as they dry. 

• Place the press somewhere warm and dry.  Placing the press on its long edge on top of a 
ventilated aluminum or aluminum-lined box containing incandescent light bulbs allows 
for quick drying.  Remove plants after several days when they are thoroughly dry.   

 



 27

Suggested Herbarium Materials  
 
Herbarium and science supply businesses such as the Herbarium Supply Company 
(www.herbariumsupply.com; 800-348-2338) sell many herbarium products including mounting 
paper, plant presses, blotting paper, and cardboard spacers.  When ordering herbarium mounting 
paper, look for acid-free, non-glossy, 100% rag, and heavy or standard weights.   
 
Preparing Dried Specimens for Shipment to an Herbarium 

 
1. Package specimens. Place each dried specimen with unique identifier clearly marked on 

the newsprint or mounting paper in the fold of a single sheet of newspaper and place all 
of the newspaper/specimens between two pieces of cardboard.  Tie or rubber band the 
cardboard bundle together, and put it into a padded envelope or a box.  As long as the 
package is going to or from an educational institution, a special 4th class mailing rate 
called “Library Rate” can be used. 

 
2. Label information. Both of the herbaria utilized by the WDNR label the dried plant 

specimens themselves.  Prepare an electronic spreadsheet with the relevant information 
for each specimen.  Send the file to Mark Wetter (mawetter@wisc.edu) for the Madison 
herbarium or to Robert Freckmann (rfreckma@uwsp.edu) for the Stevens Point 
herbarium.  Each row (i.e. each specimen) in the file will need a unique identifier such as 
the collector’s initials followed by a specimen number.  Use the same identifier on the 
specimen so the herbaria can match the label to the specimen.  Each row of the 
spreadsheet should include columns for the following (column heading in bold, example 
in plain text): 

 
a. Specimen Identifier  CD2009-01 
b. Collector Name Isabel Velez 
c. Preparer's Name (If different from collector)  Chad Douwe 
d. Lake Name Little John Jr. 
e. County Vilas 
f. Date collected 7 July 2009 
g. Specimen ID Potamogeton spirillus, Spiral-fruited pondweed 
h. Habitat muck over sand 
i. Associated species (if known) Najas gracillima, Potamogeton friesii 
j. TRS T41N R07E S29 
k. WBIC 1861700 
l. More detailed location (if known) SW edge of lake, 1 m depth 
m. GPS lat/long coordinates (if known) N 46o15.037' W090o01.804' 
n. Herbarium of deposition UWSP  

 
3. Send pressed plants to Mark Wetter or Ted Cochrane (UW- Madison), or to Dr. Robert 

Freckmann (UW-Stevens Point).  Please notify the herbarium of your intention and 
wait for confirmation before sending plants: 

 
 

http://www.herbariumsupply.com/


 28

Mark Wetter or Ted Cochrane 
University of Wisconsin-Madison Herbarium  
Department of Botany, Birge Hall  
430 Lincoln Drive  
Madison, WI 53706-1381  
tel.: (608) 262-2792  
FAX: (608) 262-7509 
www.botany.wisc.edu/herbarium/ 
 
Dr. Robert Freckmann 
Robert Freckmann Herbarium 
0310 CNR Addition  
1900 Franklin Street  
Stevens Point, WI  54481 
rfreckma@uwsp.edu 
 

4. Send electronic record to the WDNR. Please send a copy of the electronic herbarium 
file along with the plant data to DNRBaselineAquaticPlants@wisconsin.gov. 

 
 
CONCLUSIONS 
 
There will be four products from each plant survey.  First, there will be the raw data from the 
quantitative survey which provides a lakewide plant species list and distribution and rake 
fullness data for each species observed.  Second, there will be summary statistics useful in 
characterizing and comparing populations.  Third, there will be observations from the general 
boat survey.  Fourth, voucher specimens will provide a catalog of plant species present in the 
lake and will bolster the state collections.  All electronic data should be sent by email to the 
WDNR (DNRBaselineAquaticPlants@wisconsin.gov). 
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Appendix 1 
Current (02/2010) contact information for regional WDNR aquatic plant management (APM) and lake coordinators 

 
Northern Region (NOR) 

(Ashland, Barron, Bayfield, Burnett, Douglas, Florence, Forest, 
Iron, Langlade, Lincoln, Oneida, Polk, Price, Rusk, Sawyer, Taylor, 

Vilas, & Washburn Co.)  
 

 
 

Frank Koshere 
APM Coordinator 

715-392-0807 
frank.koshere@wisconsin.gov 

 
Kevin Gauthier, Sr. 

Florence, Forest, Langlade, Lincoln, Oneida, & Vilas Co. 
715-365-8937 

kevin.gauthiersr@wisconsin.gov 
 

Pamela Toshner 
Barron, Bayfield, Burnett, Douglas, Polk, & Washburn Co. 

715-635-4073 
pamela.toshner@wisconsin.gov 

 
Jim Kreitlow 

Ashland, Iron, Price, Rusk, Sawyer, & Taylor Co. 
715-365-8947 

james.kreitlow@wisconsin.gov 
 
 
 
 

Southeast Region (SER) 
(Kenosha, Milwaukee, Ozaukee, Racine, Sheboygan, Walworth, 

Washington, & Waukesha Co.) 
 

 
 

Heidi Bunk 
: Ozaukee, Sheboygan, Walworth, Washington, & Waukesha Co. 

262-574-2130 
heidi.bunk@wisconsin.gov 

 
Craig Helker 

Kenosha, Milwaukee, & Racine Co. 
262-884-2357 

craig.helker@wisconsin.gov 
 

South Central Region (SCR) 
(Columbia, Dane, Dodge, Green, Grant, Iowa, Jefferson, Lafayette, 

Richland, Rock, & Sauk Co.) 
 

 
 

Susan Graham 
Lake & APM Coordinator 

608-275-3329 
susan.graham@wisconsin.gov 
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Northeast Region (NER) 
(Brown, Calumet, Door, Fond du Lac, Green Lake, Kewaunee, 

Manitowoc, Marinette, Marquette, Menominee, Oconto, 
Outagamie, Shawano, Waupaca, Waushara, & Winnebago Co.) 

 

 
 

Mary Gansberg 
Kewaunee, Door, Manitowoc, & Menominee Co. 

920-662-5489 
mary.gansberg@wisconsin.gov 

 
Ted Johnson 

Green Lake, Marquette, Waupaca, & Waushara 
920-787-4686 ext. 3017 

tedm.johnson@wisconsin.gov 
 

Mark Sesing 
Fond du Lac, Outagamie, & Winnebago Co. 

920-485-3023 
mark.sesing@wisconsin.gov 

 
Jim Reyburn 

Brown, Oconto, & Shawano Co. 
920-662-5465 

james.reyburn@wisconsin.gov    
 

Greg Sevener 
Marinette Co.      
715-582-5013 

gregory.sevener@wisconsin.gov 
 
 

West Central Region (WCR) 
(Adams, Buffalo, Chippewa, Clark, Crawford, Dunn, Eau Claire, 

Jackson, Juneau, La Crosse, Marathon, Monroe, Pepin, Pierce, 
Polk, Portage, St. Croix, Trempealeau, Vernon, & Wood Co.) 

 

 
 

Scott Provost 
APM Coordinator 

715-421-7881 ext. 3017 
scott.provost@wisconsin.gov 

 
Buzz Sorge 

Lake Coordinator 
715-839-3794 

patrick.sorge@wisconsin.gov 
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Appendix 2 
 
This appendix contains examples of statistical outputs created through the point-intercept sampling method for Kathan Lake, Oneida County.  
The data was collected during a survey conducted August 21-22, 2007. 
 

       Table 1. Summary Statistics 
 

Total number of sites set-up 203
Total number of sites visited  171
Total number of sites with vegetation 149
Total number of sites shallower than maximum depth of plants 165
Frequency of occurrence at sites shallower than maximum depth of plants 90.30
Simpson Diversity Index 0.94
Maximum depth of plants (ft)  9.50
Number of sites sampled using rake on Rope (R) 0
Number of sites sampled using rake on Pole (P) 171
Average number of all species per site (shallower than max depth) 3.96
Average number of all species per site (veg. sites only) 4.39
Average number of native species per site (shallower than max depth) 3.56
Average number of native species per site (veg. sites only) 3.95
Species Richness  37
Species Richness (including visuals) 38
Species Richness (including visuals & boat survey) 40
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Table 2. Individual species frequency of occurrences 
Common Name Scientific Name % Frequency 

(Littoral) 
% Frequency 
(Whole lake) 

% Frequency  
(in vegetated areas) 

Relative Frequency 
(%) 

Bushy pondweed Najas flexilis 41.2 39.8 45.6 10.4 
Common waterweed Elodea canadensis 40.6 39.2 45.0 10.2 
Eurasian water milfoil* Myriophyllum spicatum* 40.0 38.6 44.3 10.1 
Filamentous algae Algae spp. 26.1 25.1 28.9 6.6 
Coontail Ceratophyllum demersum 23.0 22.2 25.5 5.8 
Stoneworts Nitella spp. 21.8 21.1 24.2 5.5 
Watershield Brasenia schreberi 20.6 19.9 22.8 5.2 
Small bladderwort Utricularia minor 17.6 17.0 19.5 4.4 
Small pondweed Potamogeton pusillus 17.0 16.4 18.8 4.3 
Common bladderwort Utricularia vulgaris 16.4 15.8 18.1 4.1 
Wild celery Vallisneria americana 15.2 14.6 16.8 3.8 
Flat stem pondweed Potamogeton zosteriformis 13.9 13.5 15.4 3.5 
Stiff pondweed Potamogeton strictifolius 11.5 11.1 12.8 2.9 
Ribbon leaf pondweed Potamogeton epihydrus 9.1 8.8 10.1 2.3 
White water lily Nymphaea odorata 7.9 7.6 8.7 2.0 
Muskgrasses Chara spp. 7.3 7.0 8.1 1.8 
Freshwater sponge Sponge spp. 6.1 5.8 6.7 1.5 
Moss Moss spp. 6.1 5.8 6.7 1.5 
Large-leaf pondweed Potamogeton amplifolius 5.5 5.3 6.0 1.4 
Spiny-spored quillwort Isoetes echinospora 4.9 4.7 5.4 1.2 
Waterwort Elatine minima 4.2 4.1 4.7 1.1 
Creeping spikerush Eleocharis palustris 4.2 4.1 4.7 1.1 
Water horsetail Equisetum fluviatile 4.2 4.1 4.7 1.1 
Northern water milfoil Myriophyllum sibiricum 4.2 4.1 4.7 1.1 
Thin floating-leaf bur-reed Sparganium sp. 4.2 4.1 4.7 1.1 
Spatterdock Nuphar variegata 3.6 3.5 4.0 0.9 
Spiral-fruited pondweed Potamogeton spirillus 3.6 3.5 4.0 0.9 
American bur-reed Sparganium americanum 3.6 3.5 4.0 0.9 
Shoreweed Littorella uniflora 3.0 2.9 3.4 0.8 
Brown-fruited rush Juncus pelocarpus f. submersus 2.4 2.3 2.7 0.6 
Variable pondweed Potamogeton gramineus 2.4 2.3 2.7 0.6 
Twin-stemmed bladderwort Utricularia geminiscapa 1.8 1.8 2.0 0.5 
Pipewort Eriocaulon aquaticum 0.6 0.6 0.7 0.2 
Clasping leaf pondweed Potamogeton richardsonii 0.6 0.6 0.7 0.2 
Broad-leaved arrowhead Sagittaria latifolia 0.6 0.6 0.7 0.2 
Thin-leaved pondweed Potamogeton sp. 0.6 0.6 0.7 0.2 
Flat-leaved bladderwort Utricularia intermedia 0.6 0.6 0.7 0.2 
Cattail  Typha sp. Visual Visual Visual Visual 
Needle spikerush Eleocharis acicularis Boat Survey Boat Survey Boat Survey Boat Survey 
Three-way sedge Dulichium arundinaceum Boat Survey Boat Survey Boat Survey Boat Survey 
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       Table 3. Number of sites where species was found and average rake fullness rating 
Common Name Scientific Name # sites where species 

was found 
# sites where species was 
found (including visuals) 

Average rake 
fullness rating 

Bushy pondweed Najas flexilis 68 68 1.28 
Common waterweed Elodea canadensis 67 67 1.28 
Eurasian water milfoil* Myriophyllum spicatum* 66 71 1.47 
Filamentous algae Algae spp. 43 43 1.00 
Coontail Ceratophyllum demersum 38 38 1.37 
Stoneworts Nitella spp. 36 36 1.00 
Watershield Brasenia schreberi 34 58 1.68 
Small bladderwort Utricularia minor 29 29 1.10 
Small pondweed Potamogeton pusillus 28 28 1.14 
Common bladderwort Utricularia vulgaris 27 27 1.30 
Wild celery Vallisneria americana 25 26 1.36 
Flat stem pondweed Potamogeton zosteriformis 23 25 1.22 
Stiff pondweed Potamogeton strictifolius 19 19 1.16 
Ribbon leaf pondweed Potamogeton epihydrus 15 18 1.27 
White water lily Nymphaea odorata 13 42 1.69 
Muskgrasses Chara spp. 12 12 1.25 
Freshwater sponge Sponge spp. 10 11 1.00 
Moss Moss spp. 10 10 1.20 
Large-leaf pondweed Potamogeton amplifolius 9 10 1.33 
Spiny-spored quillwort Isoetes echinospora 8 11 1.00 
Waterwort Elatine minima 7 8 1.00 
Creeping spikerush Eleocharis palustris 7 9 1.14 
Water horsetail Equisetum fluviatile 7 15 1.43 
Northern water milfoil Myriophyllum sibiricum 7 7 1.00 
Thin floating-leaf bur-reed Sparganium sp. 7 7 1.00 
Spatterdock Nuphar variegata 6 22 1.17 
Spiral-fruited pondweed Potamogeton spirillus 6 6 1.00 
American bur-reed Sparganium americanum 6 11 1.50 
Shoreweed Littorella uniflora 5 5 1.00 
Brown-fruited rush Juncus pelocarpus f. submersus 4 5 1.25 
Variable pondweed Potamogeton gramineus 4 5 1.00 
Twin-stemmed bladderwort Utricularia geminiscapa 3 3 1.00 
Pipewort Eriocaulon aquaticum 1 2 1.00 
Clasping leaf pondweed Potamogeton richardsonii 1 1 2.00 
Broad-leaved arrowhead Sagittaria latifolia 1 1 1.00 
Thin-leaved pondweed Potamogeton sp. 1 1 1.00 
Flat-leaved bladderwort Utricularia intermedia 1 1 1.00 
Cattail  Typha sp. Visual 3 n/a 
Needle spikerush Eleocharis acicularis Boat Survey Boat Survey n/a 
Three-way sedge Dulichium arundinaceum Boat Survey Boat Survey n/a 
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Appendix 3 
 

Creating a Plant Distribution Map Using Point Intercept Data in ArcGIS 9.3 
 
This is a protocol for making a plant distribution map using ArcGIS 9.3 and the Excel (2003 
version) file of data from the point intercept (PI) survey. This protocol can be changed in a 
number of different ways and still produce a similar product. The best way to make PI-based 
maps depends on the particular dataset; however, this procedure works well in most cases. 
Similar images may be created in PowerPoint or in photo editing software if the dataset is not 
large or complex. 
 

1. After entering the PI survey data into the Aquatic Plant Survey Data Workbook 
(Appendix-C.xls), save the file using a unique name. We recommend the convention: 
Lake_County_WBIC_(YYYY).xls 

 
2. Prepare <Lake_County_WBIC_(YYYY).xls> For Join 

a. Open file in Excel 
b. File  Save As  Lake_County_WBIC_(YYYY)_JOIN.xls (DO NOT 

MODIFY ORIGINAL FILE) 
c. Delete all worksheets except for ENTRY and ARCGIS TEMPLATE (make sure 

to scroll left and delete the README sheet) 
i. Click on worksheet tab; Edit  Delete Sheet  Delete 

d. Delete the following columns  
i. Entry columns (A & I) and calculated columns (B-H) 

1. Columns B-H are normally hidden. To “unhide” them, cursor over 
the column heading (A) at the top of the sheet and click/drag to 
highlight it and the adjacent column (I). Right click the highlighted 
region, then select unhide. Columns B-H are colored blue. Now 
delete all columns A-I. 

ii. Latitude, Longitude columns (possibly hidden, located between sampling 
point and depth columns) 

iii. Replace first row of ENTRY with ARCGIS TEMPLATE 
1. Copy the entire first row of truncated species names from the 

ARCGIS TEMPLATE worksheet 
2. Highlight the first row on the ENTRY worksheet and replace with 

the template (Edit  Paste) 
iv. Species columns with no data 

1. Add a count row to identify empty columns to delete 
a. Select all cells and remove any validation 

i. Select All (Ctrl-A) 
ii. Data  Validation  OK  Allow Any Value  

OK 
b. In the row below the last sampled point, and in the first 

column under a plant species, enter the formula  =counta( 
c. Then highlight the column up to the first sampling point. 

The beginning of this procedure is depicted below.  
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d. Finally, add a closing ) and hit enter. The final formula will 

be similar to this: =counta(G2:G500) 
e. Point the cursor over the bottom right corner of the cell 

until cursor turns into a “+”.  Click/Drag this formula all 
the way across to the end of the species list.    

f. Delete any columns where the sum row is equal to 0 
g. Then delete the sum row 

e. Delete any rows after the last applicable sample point 
i. The “sample_pt” column is usually populated up to 4000 points; delete 

any rows where the sampling point column is numbered, but these sample 
points are greater than the number of points set-up in the lakewide grid, 
and therefore the row doesn’t contain any information. 

f. Add a “dummy” row so all data imports into ArcGIS as “text” 
i. Add a row directly above the first sampled point 

ii. In this newly created row, under the Sampling Point column, enter the 
number equal to the total number of sample points plus 1 (i.e. total 
sampling points in example image is 187. The number 188 would be 
entered into the “dummy” row under the sampling point) 

g. Enter “Z” in all other cells in all columns that contain any information  

h. Save the file and close Excel 
3. Save the lake specific polygon and point shapefiles to a folder on a local drive 

a. We’ll refer to this folder as “MapFolder” 
 

4. Open ArcMap 
a. Select to Start using ArcMap with “a new empty map” and click “OK” 
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5. Add Data (either method “a” or “b”) 

a. Using Add Data Button 
i. Select the “Add Data” button; or File  Add Data 

ii. Navigate to MapFolder 
iii. Highlight both the lake polygon (lake_country_WBIC_poly.shp) and point 

(lake_county_WBIC_XXmpts.shp) shapefiles 
iv. Click on ‘Add’ 

b. Directly from ArcCatalog 
i. Situate ArcMap and ArcCatalog windows so that you can see both 

ii. Navigate to MapFolder in ArcCatalog 
iii. Highlight both the lake polygon (lake_county_WBIC_poly) and point 

(lake_county_WBIC_XXmpts) shapefiles 
iv. Drag and drop these shapefiles into ArcMap 
v. Note: Shapefiles should only be saved, deleted, moved, etc. in ArcCatalog. 

Using Windows Explorer with shapefiles can result in accidental deletion 
of individual shapefile files (i.e. *.shp, *.dbf, *.sbn, *.shx, *.sbx, and *.sbn 
files must all be stored together. ArcCatalog packages these files together 
so nothing gets lost) 

 
6. Defining Shapefile Projections 

a. If after adding in your shapefiles a warning message regarding “Unknown Spatial 
Reference” appears, the shapefiles coordinate system is not defined 

i. To define and verify projection, please contact 
DNRBaselineAquaticPlants@wisconsin.gov 

ii. Alternatively, the shapefile projection can be defined manually by using 
the Define Projection Tool located in ArcToolbox 

1. ArcToolbox  Data Management Tools  Projections and 
Transformations  Define Projection 

2. Input Dataset or Feature Class 
a. Select the shapefile that needs a defined projection 

3. Click on the browse button (right side of dialog box) 
4. In the Spatial Reference Properties dialog box, click on the 

“Select” button 
5. Browse for the correct coordinate system 

a. Projected Coordinate System  State Systems  NAD 
1983 HARN Wisconsin TM.prj; Click Add. 

i. Do not use the US Feet system 
ii. The coordinate system name may also be displayed 

as NAD 1983 HARN Transverse Mercator 
iii. Coordinate system parameters: 

1. Projection  Transverse Mercator 
False Easting  520000.00000000 
False Northing  -4480000.000000 
Central Meridian  -90.00000000 
Linear Unit  Meter 

mailto:DNRBaselineAquaticPlants@wisconsin.gov
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6. Select “OK” on Spatial Reference Properties dialog box, and “OK” 
on define projection tool 

 
7. Edit Attribute Table for point shapefile 

a. Open Attribute Table 
i. Right click on point shapefile in 

ArcMap table of contents 
ii. Select “Open Attribute Table” 

b. Add a Field 
i. Select the “Options” button  “Add 

Field” 
ii. Name: Join_ID 

iii. Type: Double 
iv. Precision: 10 
v. Scale: 3 

c. Populate Join_ID Column 
i. Right click on “Join_ID” column heading 

ii. Select “Field Calculator” 
iii. If Field Calculator warning message pops up, click “Yes” 
iv. Set expression by double-clicking FID in the “Fields:” box and typing +1. 

The white box under “Join_ID =” should now read [FID] +1  
v. Click “OK” 

vi. Your Join_ID column 
should now be populated in 
sequential order, starting 
with point #1 at the top 

vii. Close the attribute table 
viii. Note: This expression is 

assuming that each unique 
ID was based off of the 
calculation [FID] +1 when 
creating the initial point 
file. If the unique ID’s were 
not created in sequential order based on the FID field, then calculate 
Join_ID field accordingly (example: Truncate a unique ID such as 
‘Como001’ so that it just reads ‘001’ in the Join_ID field.) 

 
8. Join shapefile to <Lake_County_WBIC_(YYYY)_JOIN.xls> 

a. Right click on point shapefile in ArcMap table of contents 
b. Select Joins and Relates  Join… 
c. Set the following options: 

i. Join Attributes from a table 
ii. Join will be based on “Join_ID” 

iii. Choose the table to join to this layer 
1. Click on Window Folder (See arrow) 
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2. Navigate to and 
double-click on the 
Excel file saved in 
step 2 

3. Double-click on  the 
‘ENTRY $’ sheet  

4. Click “Add” 
iv. Base the join on 

“sample_pt” 
v. Join Options: Keep All 

Records (If using ArcGIS 
9.2, these options can be 
viewed by clicking the 
“Advanced” button) 

vi. Click “OK” 
vii. If prompted to create index, 

select “Yes” 
 

9. Export joined shapefile to make it permanent 
a. Right click on joined point shapefile in 

ArcMap table of contents 
b. Select Data  Export Data 
c. Set the following options: 

i. Export: All Features 
ii. Use the same coordinate system as: 

this layer’s source data 
iii. Output shapefile or feature class: 

Save in MapFolder as Lake_County_WBIC_ XXpts_YEAR_JOIN.shp 
d. Click “OK” 
e. When asked if you want to add the exported data to the map as a layer, select 

“Yes” 
i. This final joined shapefile will now be referred to as “Joined Point 

Shapefile” 
f. Remove the Join from the original point shapefile 

i. Right click on point shapefile in ArcMap table of contents 
ii. Select Joins and Relates  Remove Join(s)  Remove All Joins 

g. In the table of contents, uncheck or remove the original point shapefile that was 
used to create the Joined Point Shapefile. 

 
10. Check Join Results 

a. Right click on the Joined Point Shapefile in the table of contents 
b. Select “Open Attribute Table” 
c. Verify that Join was successful 

i. All data present in Excel file should now be located in the Joined Point 
Shapefile attribute table, and the Join_ID and Sample_Pt columns will be 
identical 
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11. Display Plant Distribution Data 

a. Right click on the Joined Point Shapefile in the table of contents 
b. Select “Properties” 
c. Select “Symbology” tab 
d. On left side of dialog box under “Show:”, select “Categories – Unique Values, 

Many Fields” 
e. Value Fields should be “Comments”. Be sure to select the appropriate Comments 

field, as there may be two that appear similar. 
f. You will then choose additional Value Fields to display species information (i.e. 

If you want to display both EWM and CLP species information, then both EWM 
and CLP need to be chosen as Value Fields) 

g. Select “Add All Values” 
i. All possible values are now displayed, separated by a comma. Each 

position indicates the unique values for each Value Field you designated 
in steps e & f, in the order entered. That is, if you selected ‘comments’, 
‘EWM’, and ‘CLP’ as your value fields, the first value might read: ‘ , , ‘ 
indicating points that were sampled, but had neither a comment, EWM, 
nor CLP present. The next value might read ‘ , ,1’, which includes points 
with no comments, no EWM, and fullness rating of 1 for CLP. 

ii. Points with information for the ‘comments’ value field were likely not 
sampled; the comment listed should clarify how to work with these points. 

h. Un-check <all other values> box 
i. Double-click on symbol next to each value to set symbology 

i. You must now choose appropriate symbols and colors for the different 
variables being expressed.  

ii. Typically we use increasing sizes of a green circle for EWM density 
ratings (values: 1, 2, 3), a small light green circle for visuals (V), a small 
black dot for sites sampled that had no relevant plant data, and a small “x” 
symbol for all sites not sampled  

j. You can change the label name of the 
symbol being represented by clicking 
on the respective space under “Label”. 
(e.g. change “ , ” to “No EWM”; “ ,1” 
to “1”; “ ,V” to “Visual”; “Deep, ” to 
“Not Sampled”)  

 
k. You can also group values 

together (e.g. No 
Information, Deep, 
Shallow, etc) 

i. Hold down the Shift 
key and highlight 
all rows that should 
be grouped 



 

 40

ii. Right click on highlighted rows and select “Group Values” 
iii. The final Layer Properties dialog box should look similar to this: Note: If 

you want to change the order that these will appear in the legend, highlight 
a row and use the arrows on the right side to move. 

iv. Click “Apply” then “OK” to update symbols on map 

v. The polygon shapefile fill color and outline may also be modified 
similarly under the “Symbology” tab 

 
12. Map Page Layout 

a. Verify that the coordinate system is defined correctly for the Data Frame 
i. Select View  Data Frame Properties  Coordinate System Tab 

ii. If the coordinate system is incorrectly defined, browse for the correct 
coordinate system 

1. Predefined  Projected Coordinate System  State Systems  
NAD 1983 HARN Wisconsin TM.prj 

b. View  Layout View 
c. File  Page and Print Setup  Select Landscape or Portrait 
d. Modify size/shape of data frame to fit on entire page and serve as map border 

i. Right click data frame, select Properties, under the ‘Frame’ tab, change 
border to a thickness of 2 and select OK.  

e. Insert  North Arrow  
i. Size and position appropriately 

f. Insert  Scale Bar 
i. Select “Alternating Scale Bar 

1” and click “OK” 
ii. Double-click on Scale Bar in Layout 

view to edit properties 
iii. Set the following properties: 

1. Number of divisions: 2 
2. Number of subdivisions: 1 
3. Set units to kilometers 
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4. Click “OK” 
g. Insert  Text 

i. Double-click on Text Box to edit 
information 

1. Create text box with the 
following information: 

a. Lake Name, County, 
Date Sampled, etc. 

2. Format text as appropriate 
using “Change Symbol…” 
button 

h. Insert  Picture  Navigate to WDNR Logo (Black & White) 
i. Size and position appropriately 

i. Legend 
i. In the table of contents, modify the 

displayed name of your shapefile as 
you would like it to appear in your 
legend by single clicking on the text 

ii. Insert  Legend 
iii. Choose which layers you want to 

include in your legend 
1. Include the layer that has the plant distribution symbology 

information  
2. You may have to remove the polygon layer by highlighting it 

under “Legend Items” and clicking 
the single left angle bracket (<), then 
select “Next” 

iv. Remove the word “Legend” from the 
Legend Title and select “Next” 

v. Continue selecting “Next” and then “Finish” 
vi. Format legend text 

1. Right click on Legend and select “Properties” 
vii. Size and position legend as appropriate  

j. If you’re going to be switching between maps quickly to look at comparisons 
between years or species, we suggest making and refining the layout first, then 
saving it as an ArcMap Template so you can use the same one each time 

i. File  Save As  Save As Type: ArcMap Template 
k. Check printed map for color accuracy before you export (Step 13). Sometimes the 

colors may look different on screen, but may print with the same hue and value, 
making interpretation impossible. You can set a custom color if necessary. 

 
13. Saving Map as JPEG 

a. File  Export Map 
i. Save as type: JPEG 

ii. Set Resolution: 300 dpi 
iii. Navigate to appropriate folder and Save 
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Figure 6: Example plant distribution map created using point-intercept data and ArcGIS 9.3 software for 
Kathan Lake, Oneida County. 
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Appendix 4 
 

Creating a Plant Distribution Map Using Point Intercept Data in ArcGIS 3.3 
 
This is a protocol for making plant maps using ArcView GIS 3.3 and the Aquatic Plant Survey 
Data Workbook Excel file <Appendix-C.xls.>.  This protocol can be changed in a number of 
different ways and still produce a similar product.  The best way to make PI-based maps depends 
on the particular dataset; however, this procedure works well in most cases.  Similar images may 
be created in PowerPoint or in photo editing software if the dataset is not large or complex. 
 

1. Save the ArcView shapefiles (*.shp, *.dbf, *.sbn, *.shx, *.sbx, *.sbn) to a folder on a 
local drive. 

a. We’ll refer to this folder as “MapFolder” 
 

2. Open ArcView and create a new project with a new view. 
a. Click “yes” to add data 

 
3. Add shapefiles from MapFolder 

a. You can add multiple files at once by holding down “shift” while you click the 
individual files 

 
4. View window: select the point file 

a. Make sure both themes have the box 
checked in order to view them 

b. Click once on the point layer to activate 
that theme (raised box around that item) 

c. If necessary, drag the activated point 
layer above the polygon layer in order to 
see the sample points 

 
5. Open theme table 

a. Theme > Table    or 
b. The open theme table shortcut button 
 

6. Start editing, add variable column 
a. Table > Start Editing 
b. Edit > Add Field    

i. Enter the name of the field (e.g. EWM_2009) 
ii. Specifications ‘type’, ‘width’, and ‘decimal places’ do not need to be 

changed 
iii. Click “OK” 

 
7. Stop editing, save edits 

a. Table > Stop Editing,  ‘Yes’ to save edits 
 

8. Export point file 
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a. File > Export 
b. Select ‘dBASE’ 
c. Select MapFolder to save file 
d. Default will be named <table1.dbf> 
e. Close table 
 

9. Set-working directory 
i. File > Set Working Directory  

ii. Change working directory to MapFolder  
 
10. Save project, exit ArcView 

a. File > Save Project As > save in MapFolder (for ease of reference, lets call the file 
EWM_Map.apr) 

b. Exit ArcView 
 

11. Open file saved in step 8 with Excel 
a. Open excel; Open a file, when prompted to find the file, navigate to MapFolder 
b. In “Files of type” option bar select “All files” 
c. Open <table1.dbf> 

 
12. List information under data field created (EWM_2009) 

a. Open PI data entry excel file (WiAPMS.xls) 
b. Copy columns “Sample point, Depth, Comments, & EWM”  
c. Paste special “values” into new excel workbook 
         i. Edit > Paste Special > Values 
d. Highlight all data, sort by comments 

i. Data > Sort > Comments 
e. Enter the number 5 into EWM column for all unsampled sites (deep, terrestrial, 

non-navigable, etc) (this is so the legend can code these sites) 
f. Highlight EWM data column and replace all blanks with 0 (zero), and V (visuals) 

with 4 
i. Edit > Replace, replace all 

g. Highlight all data, re-sort by sampling site 
      i. Data > Sort > Sampling Point 

h. Copy EWM column, excluding header, paste into the .dbf file (already open, 
originally created in step 8) 

i. “Save as” this file as the original dbf file’s name (the copy you placed in 
MapFolder, not the original file, obviously) 

i. i.e. overwrite the ISS original (e.g. Kathan_Oneida_1598300_65mpts.dbf) 
with the new file you just modified in excel.  The name must be 
EXACTLY the same!! 

ii. Close excel 
 

13.  Reopen project in ArcView 
a. Open existing project 
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b. Open MapFolder and click on EWM_Map.apr (or whatever you chose to name it 
in step 9) 

 
14.  Create legend 

a. Double-click point symbol in the 
View frame to open the legend 
window 

b. In “Legend Type” option bar, 
choose “Unique Value” 

c. In “Values Field” option bar select 
“EWM_2009” column (or 
whatever column you want this 
map to show) 

d. Apply 
e. You must now choose appropriate 

symbols and colors for the 
different variables being expressed 
by the legend.  You can change the 
symbol by double clicking on it 

f. Typically we use increasing sizes 
of a green circle for EWM density 
ratings (values: 1, 2 , 3), a small 
light green circle for visuals 
(value: 4), a small black dot for 
sites sampled, but without EWM, 
(value: 0), and a small “x” symbol 
for sites not sampled (value: 5).  

g. You can change the label name of the symbol being represented by clicking on 
the respective cell under “Label”. (e.g. change “5” to “Not Sampled”, change “4” 
to Visual) 

h. The color or shading of the polygon can also be changed by double clicking on 
the theme 

 
15.  Set units 

a. View > Properties  
b. Change map units to “meters” and distance units to “kilometers” 
 

16.  Layout  
a. View > Layout 
b. Select Landscape or Portrait 
c. Double-click ‘View1’ to change map title 
d. Double-click scale bar to adjust range or units 
e. If you’re going to be switching between maps quickly to look at comparisons 

between years or species, we suggest making and refining the layout first, then 
saving it as a Template (Layout > Store as Template) so you can use the same one 
each time.  
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f. Check printed map for color accuracy before you export (step 17).  Sometimes the 
colors may look different on screen, but may print with the same hue and value, 
making interpretation impossible.  You can set a custom color if necessary. 

 
17. Save as JPEG 

a. Have the final layout window active 
b. Select File > Export 
c. In “List Files of Type” option bar, select JPEG 
d. Click ‘Options’ button 

i. Set resolution to highest number 
ii. Likely 144 DPI and Quality = 100 

e. Type file name, choose location in which to save the JPEG 
f. Click OK 

 
 

 
 

 

Figure 7: Example plant distribution map created using point-intercept data and ArcGIS 3.3 software for Kathan 
Lake, Oneida County. 
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